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1.0  Introduct ion 

Noise Model Simulation (NMSim) is a computer model that generates time histories of noise 
from moving sources accounting for the effects of real terrain on sound propagation.  NMSim has 
existed as a single-event aircraft noise model since the mid-1990s1,2 and was originally developed 
in support of noise propagation studies3, and ran on a PC under MS-DOS.  This model has 
become part of a growing trend toward simulation models for complex situations not adequately 
addressed by traditional integrated airport noise models4 and provides both quantitative analysis 
in terms of spectra and loudness metrics, and descriptive display in the form of color renditions 
and animations of noise. 

NMSim has been developed into a general-purpose noise model for the National Park Service.  
The current model includes the single-event aircraft noise capabilities of earlier versions of 
NMSim.  It also includes ground noise sources and is capable of analyzing multiple-source noise 
environments.  The new program operates on a PC under 32-bit Windows. 

Functional capabilities of this software include: 

 Interactive single event noise calculation, in a geo-referenced coordinate system 
 Tools to easily prepare input files for NMSim: 

 An Elevation Builder that generates topography from a variety of formats that 
are readily available online, 

 An Impedance Builder that generates ground impedances based on the location 
of water in the study area (based on Digital Line Graph hydrography files), 

 A Flight Track and a Ground vehicle path builder to develop aircraft flight paths, 
railroads, and roads, 

 Receiver Site Builder, which enables the placement of receiver sites throughout 
the study area, and 

 A small noise source library of representative aircraft and ground vehicles. 
 The capability to schedule and run multiple cases. 
 The creation of color renditions and animations from single or multiple-event cases. 
 The analysis of single or multiple-event noise environments, such as a full daily 

schedule of air tour flights. 
 The capability to input geospatial data in various formats such as Environmental 

Systems Research Institute (ESRI) ASCII GRID, USGS DLG and USGS DEM. 
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 The capability to work with user-specified coordinates, including a user-defined local 
Cartesian system, Universal Transverse Mercator (UTM) coordinate system with a 
datum of NAD27 or NAD83, or any arbitrary coordinate system. 

 Grid outputs of day-night average sound level (DNL), either A-weighted (dBA) or 
C-weighted (dBC) time histories, Leq, LAMAX, Time Above Ambient, Time Audible, 
etc., at specific points of interest and grids in ESRI's ASCII, and NMGF file formats. 

Figure 1-1 illustrates the complete NMSim system.  Not directly shown in Figure 1-1 is the 
NMSimVisualizer module, which generates color renderings and animations of noise footprints.  
Section 2 of this report is a tutorial that describes installation and operation of this functional 
software.  One sample case, a flight near Fort Ticonderoga, NY, is included, as well as sufficient 
data to build additional test cases.  Section 3 describes preparation of inputs for user-created 
cases.  Section 4 describes the NMSim Visualizer, and Section 5 describes the NMSim Scheduler. 
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Figure 1-1. NMSim Overall Flow Chart
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2.0 Quick Start  Tutorial  

This section discusses the basics of NMSim, including how to install the software and run a 
sample case. 

2 . 1  I n s t a l l a t i o n  

NMSim is a Windows-based program that runs under Windows 9x, NT, 2000, ME, and XP. The 
recommended hardware is a 500 MHz Pentium (or equivalent) based computer with 256 
Megabytes of RAM, and a 1024x768, 24-bit color display.  Minimum hardware is 200 MHz, 128 
MB RAM and 800x600 with 16-bit color.  If color renderings and animations are not required, 
color depth can be 8 bits. 

The software is supplied on CD.  To install NMSim, launch the ‘SetUp.exe’ program on the CD (if 
it did not launch automatically when the CD was inserted) and follow the on-screen instructions.  
Figure 2-1 shows the resultant directory structure when the default ‘Program Files’ directory is 
chosen for the installation destination. 

 

 

Figure 2-1.  NMSim Installation Directory Structure 

The subdirectories have the following roles: 

 Ambient contains some example ambient noise files.  These files consist of 1/3-octave 
band noise levels for various outdoor conditions. The structure of these files is given in 
Appendix A.  If no ambient noise file is selected audibility is calculated based on the 
threshold of hearing for the average person. 
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 ControlFiles is a folder the can be used to store control files needed by NMSim and its 
components.  Each control file has information that defines a case. These files have 
extension ‘.nms’.  There is a pre-built control file in this folder called ‘FortTiCase.nms’. 

 FortTiCase contains a pre-built set of files ready to run.  The control file 
‘FortTiCase.nms’ makes use of these files. 

 Help contains the online help documents. 
 License contains the GPL license documents. 
 NMPlot contains a full version of NMPlot (Version 4.94, Build 359).  This software is 

useful for some GIS manipulations of the Visualizer output, including the exportation 
of Shape files. 

 Output is where graphical output files (images and videos) can be stored. 
 RND (Required NMSim Data) contains icons, symbols and related supporting files. 
 Sources contains noise source data. 
 TiconderogaDLGs contain geospatial data of the Fort Ticonderoga, NY area that can 

be used to create sample NMSim cases. 
 TimFiles will contain time history files generated by running NMSim. 

In addition, NMSim will periodically generate additional directories to store working files.  As a 
video is generated, all of the intermediate frames are stored to allow future changes to the video.  
Also, when multiple cases are run using the NMSim Scheduler, the intermediate grid files are 
stored in a folder named ‘pastcasefolder’.  This folder is then used later to determine whether a 
case needs to be re-run or if it can simply be brought up from a previously generated file. 

If you create your own cases, control files for these cases can go into the ‘ControlFiles’ directory, 
but that is not necessary.  The only directories that should not be altered in any way are the 
‘RND’ directory and the ‘TimFiles’ directory. 

2 . 2  R u n n i n g  A  S a m p l e  C a s e  

When you launch NMSim you will be presented with a License splash screen.  You must accept 
the terms of the GPL license in order to proceed.  After you accept the license you will see a 
mostly blank screen with pull-down menus at the top.  Select ‘File -> Open’.  It will (by default) 
show ‘.nms’ files in the ControlFiles directory.  Select the ‘FortTi.nms’ file. This will bring up the 
dialog box as shown in Figure 2-2. 
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Figure 2-2.  NMSim Control File Dialog 

This dialog lists the necessary files and parameters to run a NMSim case. These are described in 
detail in Section 3.  A case may be modified by selecting different files and/or parameters.   ‘File - 
> New’ prompts for a case name and then brings up this dialog with empty entries. 

Clicking ‘OK’ closes the dialog and opens the main NMSim interactive analysis screen, shown in 
Figure 2-3.  This is where the action is – you direct NMSim’s calculations and see the results in 
real time. 
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Figure 2-3.  NMSim Interactive Analysis Screen 

A map of the analysis area occupies the lower left.  Terrain elevation contours are drawn in gray.  
The flight track is drawn in magenta.  Red circles mark the receiver locations.  The vehicle is 
sketched in its position along the track.  A line connects the aircraft to the currently selected 
receiver.  A display just under the map shows the coordinates and terrain elevation at the current 
mouse cursor position in Lat/Long, UTM, and a user-defined system. 

A profile box immediately above the map shows the terrain elevation profile (black) under the 
path from the source to the receiver, and a direct line of sight of the path.  If this line of sight is 
unobstructed, the line is gray.  If there is intervening terrain, the line-of-sight line is drawn in red.  
This illustration is to the same scale as the map, and the altitude and distance scales are equal, so 
angles are properly represented.  A ground property profile (blue) at the top indicates whether 
ground is hard or soft as determined by the impedance file (described in Section 3.3). 
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An empty area to the right provides a convenient place to park various information tables and 
graphs that can be brought up by either selecting them from the ‘View’ menu item, or through 
certain keystrokes.  The initial display includes the ‘Track Info’ and ‘Site Info’ tables. 

All of the information displays are updated when the aircraft is moved along its track or a 
different receiver is selected (with the exception of the time histories).  The aircraft is moved 
incrementally via the up/down arrow keys.  The site is selected by either the PgUp/PgDn keys, 
or by clicking the mouse inside one of the site circles. 

Table 2-1 lists all of the key combinations that are available for use.  This list may be brought up 
in the analysis screen by pressing F1 or by selecting the menu item ‘Help’. 

Table 2-1.  NMSim Key Commands 

 

Up Arrow ......................................................................Move forward 1 time increment 

CTRL-Up Arrow...........................................................Move forward 10 time increments 

Down Arrow................................................................Move back 1 time increment 

CTRL-Down Arrow ....................................................Move back 10 time increments 

Home .............................................................................Move to first track point 

End..................................................................................Move to last track point 

PgUp...............................................................................Select next site 

PgDn...............................................................................Select prior site 

F1.....................................................................................Bring up the online help 

F2.....................................................................................Run a full grid case and generate all time histories for that case 

CTRL-V ...........................................................................Run a full grid and all of the receiver sites and launch the NMSim Visualizer 

F3.....................................................................................Run a full receiver set case and generate time histories for each receiver site 

F4.....................................................................................Fly airplane through full track generating a time history for the current receiver, 
and bring up a plot 

Shift F4...........................................................................Generate a time history for the current receiver, and bring up a plot without the 
animation 

F5.....................................................................................Table of 1/3 octave band ground effect for receiver 

F6.....................................................................................Graph of 1/3 octave band ground effect for receiver 

F7.....................................................................................Table of spectrum for current source/receiver 

F8.....................................................................................Graph of spectrum for current source/receiver 

+.......................................................................................Zoom in 

- ........................................................................................Zoom out 

0.......................................................................................Zoom to original view 

 

You may zoom into the center of the screen by pressing the +/= key, but a more convenient way 
to zoom in is to use the mouse.  Clicking and dragging a frame anywhere on the map will then 
set that area as the current zoom.  If the area is too small (less than 10% of the full map size) an 
error chime will sound and no new zoom will be set. 
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After experimenting with NMSim and becoming more familiar with the controls, you are 
encouraged to try the NMSim Visualizer.  To start the Visualizer, either press CTRL-V or select 
the menu item ‘Output – Visualizer.’  This will bring up the dialog shown in Figure 2-4: 

 

Figure 2-4.  NMSim Grid Calculation Resolution 

This dialog is requesting a total grid size for your study area and also defines the grid resolution.  
A 40x40 grid with 75 trajectory time steps takes roughly 5 minutes to run on a 1 GHz Pentium III 
computer and results in a visually pleasing color image (see Figure 2-7).  After a total grid 
resolution has been selected the program will ask you to select a range for these calculations.  
This allows you to focus in on only a portion of the study area.  Only the grid points in the 
specified range will be calculated.  For example, if you select the x range to be 1 through 20, and 
the y range to also be 1 through 20, you have selected the lower left quadrant of the study area.  
This is shown schematically in Figure 2-6.  While this shows a square study area, any shape of 
sub-grid area is valid.  For example, the range could be 4 through 27 in the x direction and 18 
through 37 in the y direction. 

 

 

Figure 2-5.  NMSim Grid Calculation Range 
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Figure 2-6.  Example of a 40 by 40 main grid with the lower left quadrant selected as a subgrid. 

After selecting the subgrid area, clicking ‘OK’ brings up the final dialog that asks for a file name 
to save the data to.  NMSim will append the words ‘grid’ and ‘site’ to the selected file name when 
it writes the grid and the site files, respectively. 

Once a file name has been selected, the NMSim Visualizer launches automatically, bringing up 
the window shown in Figure 2-7: 
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Figure 2-7.  NMSim Visualizer Interactive Screen 

This is the NMSim Visualizer where the noise levels are rendered into colors based on the legend 
on the right hand side of the screen.  The aircraft can be advanced along the flight track the same 
way in the Visualizer as in NMSim.  Table 2-2 lists all of the key combinations available.  This list 
can be brought up in the analysis screen by pressing F1 or by selecting the menu item ‘Help’ at 
any time. 
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Table 2-2.  Visualizer Key Commands 

 
Up Arrow ......................................................................Move forward 1 time increment 

CTRL-Up Arrow...........................................................Move forward 10 time increments  

Down Arrow................................................................Move back 1 time increment 

CTRL-Down Arrow ....................................................Move back 10 time increments 

Home .............................................................................Jump to the first time increment 

End..................................................................................Jump to the last time increment 

A.......................................................................................Show A-Weighted time history  

F .......................................................................................Show Flat-Weighted time history 

C.......................................................................................Show C-Weighted time history  

Up Arrow ......................................................................Move forward 1 time increment 

CTRL-Up Arrow...........................................................Move forward 10 time increments  

Down Arrow................................................................Move back 1 time increment 

CTRL-Down Arrow ....................................................Move back 10 time increments 

Home .............................................................................Jump to the first time increment 

End..................................................................................Jump to the last time increment 

A.......................................................................................Show A-Weighted time history  

F .......................................................................................Show Flat-Weighted time history 

C.......................................................................................Show C-Weighted time history  

M......................................................................................Show Lmax with current weighting  
                                                                         (A-weight is default)  

 

 
The final step in this Quick Start tutorial is to create a video.  Begin by selecting the menu item 
‘Capture – Video.’ Then select the frames to be placed into the video, followed by selecting the 
video file name.  The Visualizer will generate all of the necessary image files and store them in a 
folder named ‘temp’.  Using a 1 GHz Pentium III computer for processing, it would take 
approximately 5 minutes to generate a video file.  After the video has been created, you will be 
given the option of viewing the video.  The video can be replayed by selecting the menu item 
‘View – Last Video’. 

This concludes the Quick Start tutorial.  For more details about NMSim and all of the support 
software, please refer to the rest of the manual. 
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3.0 NMSim Users  Manual  

NMSim represents an integrated system of several different programs working together.  To 
facilitate both ease of use and simplicity of design, NMSim employs many different files for any 
given case.  This section will guide you through building an example case to help describe in 
detail all aspects of the various programs and working files needed.  Users interested in jumping 
right in should consider following the Quick Start Tutorial in Section 2 instead. 

The first step to accessing the majority of the software features is to launch the NMSim 
executable.  After accepting the license agreement a generally blank screen with pull-down 
menus at the top will appear.  Selecting ‘File -> New’ brings up a file name selection dialog.  This 
is your opportunity to choose a name for the NMSim case about to be built.  After a file name has 
been selected, the NMSim File Loading/Building Dialog shown in Figure 3-1 will appear. 

 

Figure 3-1.  NMSim File Loading/Building Dialog 

A full NMSim case can have as many as seven input files, as seen from Figure 3-1.  Of these 
possible input files, only an Elevation File, a Trajectory File, and a Noise Source File are required.  
Pressing the appropriate button on the dialog will build these input files.  For example, to build 
an elevation file (the core file for all NMSim calculations), press the ‘Build/Edit Elevation and/or 
Impedance File’ button.  This will launch a new program that allows you to either build a new 
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elevation file or edit the one currently selected.  Similarly, all of the other ‘Build/Edit’ buttons 
will bring up the other programs necessary to generate NMSim input files.  The next several 
sections deal with these input files and discuss the programs used to generate them. 

The loading dialog is accessible anytime during the build process, but at some stages certain 
elements are disabled.  For example, if you are building a new Elevation file, selecting the menu 
item ‘Edit’ will bring up this dialog, but only the Layer file portion of the dialog will be active.  
You may then edit or build a Layer and display it over the map you are working from.  This 
change will be carried throughout the build process. 

If you do not want to use an optional file, either delete the file name completely or place a 
hyphen (‘-‘) into the field instead of a file name.  For example, if you did not want to see a 
Background Layer file, which was created earlier, placing the hyphen into that field will remove 
that file from the NMSim case. 

3.0.1 Navigating Within NMSim 

NMSim is not a single program but rather is a collection of many different programs.  Depending 
on what aspect of your case you are working on will determine which program is operating.  All 
of the programs, however, have the exact same look and feel, so it is possible to be uncertain 
which program you are in.  The title bar at the top of the window will always let you know what 
program you are working on. 

When you access any of the sub-programs (like the Elevation File Builder), the main program will 
be paused until you are finished.  Most of the sub-programs are accessible through the main 
dialog shown in Figure 3-1, but they are all also launchable directly and by themselves.  You do 
not need to be running NMSim in order to run the Elevation File Builder, the Visualizer, or any of 
the other programs.  They will all function independently. 

Another important fact to remember is that NMSim also uses a large number of case files to 
define your study.  The locations of these case files is stored in your NMSim control file (*.nms).  
If you move your files around, NMSim will not know where they are and you will be asked to re-
specify their locations.  For this reason it is advisable not to rearrange your case files once you 
have created a case or else you will be forced to re-specify the locations of all of your files. 

3 . 1  B u i l d i n g  a  N e w  C a s e  

When a new NMSim case is created, all of the fields in the NMSim File Loading/Building Dialog 
(Figure 3-1) are blank with the exception of the Source file (which is set as a default ‘Omni 
Direction’ source).  The Elevation File, the Trajectory File and the Source File are all mandatory, 
and NMSim will not allow you to continue without these files. 
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The first file that needs to be created is the elevation file.  In fact, it is not possible to build a 
Trajectory File or a receiver site file without a legitimate elevation file. The elevation file defines 
the study area that will be used in all subsequent portions of NMSim and provides the core 
NMSim calculations with the necessary elevation data (see Section 3.2). 

The Receiver Site file, the Impedance file, the Layer file and the Ambient Noise file are all 
optional, although each contains values it adds to the process (see Section 3.5). 

The Trajectory File defines the motion of the source in three spatial dimensions and time (see 
Section 3.6). 

The next sections of the manual are laid out in the order most users would likely create each file. 
With the exception of the Elevation file, which must be created before either the Trajectory File or 
the Receiver Site file, there is no required order. 

3 . 2  E l e v a t i o n  F i l e  

The elevation file is the core file for all NMSim calculations.  This file contains details about the 
study area, alternate coordinate systems used and a grid of elevations covering the whole study 
area.  It is this elevation data that NMSim uses when determining what acoustic attenuation has 
occurred from the propagation over terrain. 

Building the elevation file requires input data describing the topography of the study area.  
Before discussing the process of building an elevation file it is important to understand what 
input files are available and the impact they have on a NMSim case. 

3.2.1 Input Files 

Before going ahead with building an elevation file, all the necessary input files must be collected.  
To do this it is imperative to know the exact details about the geographic location and extent of 
the study area.  Once this has been determined you may go about the process of collecting the 
necessary files. 

NMSim can accept input terrain files in four formats:  Digital Line Graphs (DLGs), Digital 
Elevation Model (DEMs), Military Digital Terrain Elevation Data files (DTED), and files in the 
ESRI ASCII exchange format.  All of these files come in a variety of formats and it is important to 
get the correct format files for NMSim to work with.  Some DEM and DLG files are available free 
from the USGS at http://edc.usgs.gov/geodata.  This web site also lists places where files may be 
purchased. 
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It is recommended that you set up a separate folder to hold all of the input files.  They will 
consequently be easily accessible and, since many files are often needed to fully cover a study 
area, help to reduce file/directory clutter on the computer. 

3.2.1.1 Digital Line Graph (DLG) Files 

Digital Line Graph files are generated from maps currently available from the USGS.  To quote 
from the DLG users manual, “Digital Line Graph data are currently derived by digitizing map 
features as line graph elements from cartographic source materials”5.  In other words, they are 
direct digital representations of USGS maps.  This means that, amongst other details, the files 
may also contain data about roads, power lines, municipal boundaries, elevation lines, water, etc. 
that are on the map.  To reduce the clutter inherent in this system, each different kind of data set 
is stored in its own file. 

There are a total of eleven different file types used to store all of the data on a map, although not 
every area will have every file type.  The files are denoted with a two-letter abbreviation in the 
name.  Table 3-1 lists the file types with a brief description of the contents of the file.  For the 
purposes of generating an elevation file, only the Hypsography (HP) files are used.  The other 
files are used to generate a background layer file. 

Table 3-1.   DLG Category Names and Abbreviations 

Long Form Abbreviation Prominent Features 

Hypsography HP Elevation Lines. 

Hydrography HY All bodies of water from oceans to streams. 

Vegetative Surface Cover SC Trees, scrub, farms, grass lands, etc. 

Non- Vegetative Features NV Lava, sand, gravel, etc. 

Boundaries BD Civil boundaries, including the following:  State, 
commonwealth, and territory; county, parish, borough, and 
municipal; township or minor civil division; city or 
incorporated place; Federal reservation; other reservation; 
large parks and small parks. 

Survey Control and Markers SM Survey markers. 

Roads and Trails RD All roads and trails. 

Railroads RR All railroads. 

Pipeline, Transmission Lines, and 
Miscellaneous Transportation 

MT All remaining transportation features, including airports. 

Man Made Features MS Forts, mines, waterworks, buildings, etc. 

U.S. Public Land Survey System PL Many individual features are recorded here including local 
subdivisions, survey corners, lines, and areas within public 
domain States. 

The abbreviation for each file is a two-letter code that is inserted into the file name.  The rest of 
the file name is generally a coded set of numbers.  For example, a typical hydrography file for the 
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Fort Ticonderoga area is named ‘445064.HY.opt’, and a boundary file for the same area is named 
‘gs1bdf03.do’.  NMSim makes use of these abbreviations in determining the type of a particular 
DLG file. Renaming these files is not recommended. 

DLG files come in a variety of scales: 

 1:24,000-scale 
 1:62,500-scale 
 1:63,360-scale 
 1:100,000-scale 

  1:2,000,000-scale 

The USGS stores these data files in two different formats, the Optional format and the Spatial 
Data Transfer Standard (SDTS).  For NMSim only the Optional format files should be used. 

If the 1:100K Optional format DLG files are used, they may be downloaded free from the USGS 
website address listed above.  The other scale files can be purchased from the same website.  The 
1:100K files are organized into quadrangles that are 30 minutes in latitude and 60 minutes in 
longitude.  The quadrangles are generally named after the predominant city within that 
quadrangle and are indexed on the USGS webs site alphabetically and by the state they are in.  

The quadrangles themselves are subdivided into an East and West half.  Within each half 
quadrangle the DLG files are once again subdivided into types (see Table 3-1).  Generally there 
will be 4 files of any given type in a half of a quadrangle but some instances, where there is a 
large amount of data, there may be 16 files. 

In general, DLG files are best at resolving areas where there are large changes in elevation over 
short distances.   This is because the DLG files contain the elevation contours.  This means that if 
there is a cliff, all of the elevation drop will be correctly represented by the DLG files.  They are 
less accurate at representing gentle slopes because the elevation contour lines are much farther 
apart. 

3.2.1.2 Digital Elevation Models 

The DEM files are generated by sampling elevations at regular intervals to generate a grid of 
elevations.  The shape and style of these grids depends on the scale of the map.  The original data 
used for the sampling may be the physical maps (the same as those used for the DLG files), DLG 
files, and/or satellite imagery data. 
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The DEM files come in a range of scales: 

1:24,000-scale 
1:63,360-scale 
1:100,000-scale 
1:250,000-scale 

The USGS stores these data files in two different formats.  NMSim does not support the Spatial 
Data Transfer Standard (SDTS) format.  The other format is known as the ‘Optional’ format.  
Only the 1:250K scale files are available from the USGS for free, but all scale versions of these files 
are available for a nominal fee. 

If the 1:250K DEM files are used, they may be downloaded directly from the USGS website 
address given above.  Each file covers an area 1 degree of latitude by 1 degree of longitude in 
extent.  They are generally named after the predominant city within that area and are indexed on 
the USGS website alphabetically and by the state they are in. 

DEM files are best at resolving gradual changes in elevation, such as shore lines.  This is because 
they have data at evenly spaced intervals regardless of the terrain features, unlike DLG files. 

3.2.1.3 ESRI ASCII Files 

ESRI ASCII format files are simple ASCII files that can be used to export data out of an ESRI 
product.  The files contain no scale identification and great care must be taken when using these 
types of files. 

The ESRI ASCII format stores data in a regular grid where the height and width of each grid cell 
is the same.  The lower left corner of the study area is the only coordinate given in the file and all 
subsequent locations are based on that corner. 

For NMSim, the ESRI ASCII file must store the lower left corner and the grid cell size in decimal 
degrees.  The altitude must be stored in meters relative to the mean sea level (MSL).  Also, the 
longitude should be negative for the southern hemisphere and the latitude should be negative for 
the western hemisphere. 

3.2.1.4 Digital Terrain Elevation (DTED) Files 

DTED files are created by the National Imagery and Mapping Agency (NIMA), an office in the 
DOD.  DTED files store elevation data in regular grids based on a geographic (Latitude and 
Longitude) system.  The data is used by the Elevation file builder by first converting it to UTM 
84.  For a more detailed description of the DTED files and the various levels of detail available, 
consult the NIMA on-line documentation at: 

“http://geoengine.nga.mil/geospatial/SW_TOOLS/NIMAMUSE/webinter/rast_roam.html”. 
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3.2.2 A Word about Coordinate Systems 

The data stored in these files comes in a variety of formats.  NMSim is designed to deal with all of 
the different formats, but it is useful for you to understand how the data can be stored and what 
impact it can have on the NMSim case. 

One of the ever-present difficulties in dealing with maps is that they project a round object 
(namely the earth) on a flat piece of paper.  Identifying where a point is on the globe requires that 
everyone interested in that location understands exactly how that projection was used and how it 
was implemented. 

There are several ways to represent the globe in two dimensions, and two of the most commonly 
used ones are Geographic (Latitude and Longitude) and Universal Transverse Mercator (UTM). 

3.2.2.1 Latitude and Longitude 

The most commonly used coordinate system today is the Geographic system (Latitude and 
Longitude).  Lines of constant latitude run parallel to the equator from north to south while lines 
of constant longitude (call meridians) run perpendicular to the latitude lines and converge at the 
poles. 

Overall, Latitude and Longitude is a coordinate system composed of parallels of latitude and 
meridians of longitude. Both divide the circumference of the Earth into 360 degrees, which are 
further subdivided into minutes and seconds.  In geographic coordinate systems like Latitude 
and Longitude, the distance covered by a degree of longitude changes as you move towards the 
poles.  Therefore, calculations used to measure distance and calculate area using latitude and 
longitude coordinates can become quite involved.  In order to make things easier, some people 
choose to use a projected Cartesian coordinate system such as Universal Transverse Mercator. 

3.2.2.2 Universal Transverse Mercator (UTM) 

The Universal Transverse Mercator (UTM) grid system divides the earth into 60 north-south 
zones each covering 6 degrees of longitude.  Points in the zone are represented by Cartesian 
coordinates referenced to an origin at the intersection of the central longitude line (called the 
central meridian) and the equator.  UTM zones are numbered 1 through 60, starting at Longitude 
180 and proceed eastward.  The zones extend from 80° S to 84° N.  There are special UTM zones 
between 0 degrees and 36 degrees longitude above 72 degrees north latitude and a special zone 
32 between 56 degrees and 64 degrees north latitude. 

Each UTM zone is based upon the Transverse Mercator projection.  This is a type of cylindrical 
projection that can be placed to intersect at a chosen central meridian. The strength of a 
Transverse Mercator projection lies in its ability to minimize distortion of scale and distance, and 
with a separate projection for each UTM zone, a high degree of accuracy is possible. 
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UTM grid coordinates are expressed as a distance in meters to the east, referred to as the 
"easting", and a distance in meters to the north, referred to as the "northing".  Easting values are 
measured from the central meridian.  The central meridian, the middle longitude line in the zone, 
is assigned an easting value, called a false easting, of 500,000 meters. This assures that there are 
no negative coordinate values in a zone.  Grid values to the west of the central meridian are less 
than 500,000 meters and more than 500,000 meters to the east of the central meridian.  If an area 
of interest extends beyond the boundaries of a given zone, the coordinates of one zone can be 
transposed and represented in another zone, up to half the width of a zone (3 degrees of 
longitude). 

Northing values are measured from the equator.  For locations north of the equator the equator is 
assigned the northing value of 0 meters. To avoid negative numbers, locations south of the 
equator are made with the equator having the assigned value, called false northing, of 10,000,000 
meters. 

Whenever the coordinate system and projection of a map is mentioned, one must also be aware 
of its datum. A datum is a set of constants that specify the coordinate system used for calculating 
coordinates of points on the earth.  In the end, a perfect projection or datum does not exist.  All 
map projections represent tradeoffs between different types and degrees of distortion. Selecting a 
projection requires consideration of several factors, one of which is the intended use of the map.  
Some distortions of shape, distance, direction, scale, and area always result from the type of 
projection and datum chosen. 

Since there are few projected coordinate systems that cover the entire globe, NMSim has made 
Universal Transverse Mercator in the World Geodetic System (WGS) 84 datum as its default 
setting.  The decision to translate everything to UTM 84 is a conscious attempt to maintain a 
single coordinate system.  Such a system is needed due to accuracy and user interface 
considerations, the need for a product to support the widest possible range of applications (local, 
worldwide), the need to relate information from one product to data obtained from another 
source, the need to minimize errors and to ensure a smooth transition in product use from one 
part of the world to another.  The decision to use UTM was also based on several other factors: 

 UTM, as the name implies, is universal. Given a latitude/longitude pair, UTM 
coordinates can be computed unambiguously for any point between 84° N latitude 
and 80° S latitude. Given UTM coordinates and the zone number, geographic 
coordinates can be computed. 

 Because of this universality, UTM/geographic coordinate conversions are widely 
implemented in software such as Global Positioning Systems (GPS). 

 Users who need data on other, less common, projections are more likely to know how 
to convert data from UTM to their projection of interest than from other projections. 
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 UTM provides a constant distance relationship anywhere on the map.  In coordinate 
systems like Latitude and Longitude, the distance covered by a degree of longitude 
differs as you move towards the poles and only equals the distance covered by a 
degree of latitude at the equator.  The UTM system allows the coordinate numbering 
system to be tied directly to a distance measuring system. 

 Grid values increase from left to right and bottom to top.  Simple Cartesian coordinate 
mathematics can be used to calculate distance and area. 

The decision to use WGS 84 was chosen for its increased accuracy and for its global applicability.  
New and more extensive data sets and improved computer software were used in the 
development of WGS 84, the datum underlying UTM 84.  An extensive file of Doppler-derived 
station coordinates was available and, for many more local geodetic systems, improved sets of 
ground-based Doppler and laser satellite tracking data and surface gravity were available.  
Lastly, geodetic heights were deduced from satellite radar altimetry.  Thus the World Geodetic 
System provides the basic reference frame and geometric figure for the Earth. 

Regardless of what format the input files may have, NMSim converts all coordinates into UTM 
84.  For example, many DEM maps store the elevation data in a Geographic coordinate system 
based on an earlier data (called North American Datum 27 or NAD 27).  NMSim converts all of 
this data directly to a UTM 84 coordinate system.  It is important to understand this for 
exportation of data, or if data files are used that do not have an explicit reference (like ESRI ASCII 
files). 

3.2.3 Building a New Elevation File 

Once all of the files have been downloaded, it is time to begin building the Elevation file.  Click 
on the ‘Build/Edit Elevation and/or Impedance File’ button shown in the NMSim File 
Loading/Building Dialog (Figure 3-1).  This will bring up an introduction message followed by 
the dialog shown in Figure 3-2.  
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Figure 3-2.  Elevation File Case Building Dialog 

This is the place to add the various map files that you have collected.  Any combination of DLG, 
DEM, and ASCII files can be used but it is strongly recommended that only one file type be used.  
This is because small differences between the files can cause the same elevation point to show up 
in two places, thereby reducing the accuracy of the final map. 

To add a file, click the ‘Add Files’ button.  This will bring up a standard windows file selection 
dialog.  The default file type is the DLG file, but the other file types can be selected with the ‘File 
Types’ pull-down menu. 

As files are added they will show up in the dialog, along with their description on the right-hand 
side.  The total number of files is tallied at the bottom of the dialog.  If a file is added by mistake it 
can be removed by first selecting it, then pressing the ‘Remove Selected Files’ button. 

Once a complete set of files has been added, click ‘Finished’.  This will bring up a dialog asking 
you for the main UTM zone.  This is useful if the study area crosses over two UTM zones and/or 
you want all data to be represented by a specific zone (see Section 3.2.2.2).  If zero (0) is selected 
as the zone then all of the data will be transposed to the zone of the first data file listed. 
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3.2.3.1 Elevation Builder Main Screen 

With a main zone selected the elevation builder processes all of the input files. This could take a 
few moments depending on how many and which type of files there are.  When all of the data 
files have been processed the screen shown in Figure 3-3 will appear: 

 

Figure 3-3.  Elevation Building Main Screen 

Figure 3-3 shows the main window for building a new Elevation file.  To the left of the window 
are the combined elevation contours from all of the input files previously selected.  On the menu 
bar below are the current coordinates of the mouse, and to the right is a dialog box containing all 
of the crucial study area information used to generate the elevation file.  This dialog box is shown 
in Figure 3-4. 

At this point it is possible to continue on and generate a new Elevation file.  However, to help 
orient you, it is also possible to add a layer of details to the map showing the roads, trails, 
airports, and any other data of interest to you (see Section 3.4). 

3.2.3.1.1 Defining a Study Area 

To begin defining a study area you need to click the left mouse button approximately where one 
corner of the measurement area should be, then drag the marquee to cover the whole study area.  
Clicking the left mouse button again will drop the marquee and define the area. 
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There will now be a box placed over the map that covers the measurement area.  The southwest 
corner of the box has a red square and the northeast corner has a green circle.  The coordinates of 
these corners are shown in the upper portion of the study area dialog box to the right of the 
window, shown in Figure 3-4. 

 

Figure 3-4.  Dialog Showing Study Area Data 

This dialog has three main sections.  The upper section shows the corners and the height and 
width of the study area.  The middle section describes the final size of the output grid, and the 
lower section defines the coordinates of the study area’s reference point.  We will discuss each of 
these elements, working down from the upper section. 
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3.2.3.1.1.1 Study Area Corners 

The upper section, called ‘Study Area Corners’, has three buttons.  The Lat/Long and UTM 
buttons will change the view of the corner coordinates to either Lat/Long or UTM appropriately 
(the depressed button is the selected coordinate system), and the Redraw button will redraw the 
frame around the study area.  This allows you to alter the coordinates directly and see the 
changes on the map.  It does not matter which coordinate system is being used.  It is also possible 
to alter the height and width of the study area.  Clicking the ‘Redraw’ button will then redraw the 
study area starting from the southwest corner and build a new study area of the requested height 
and width.  The units of height and width are shown in the next section of the dialog box. 

3.2.3.1.1.2 Study Area Grid Information 

In the second section of the dialog box, called ‘Study Area Grid Information’, there are two 
buttons.  In this case either Feet or Meters will be selected (depressed), with feet being the 
default.  This sets the units used to display the height and width, as well as the X and Y grid 
dimension, shown at the bottom of this section of the dialog box. 

The default value for the number of grid points in the X and Y direction is 200.  This means that, 
when the final elevation file is generated, it will be generate a grid of 200x200 points of elevation 
over the study area.  The actual size of each grid point (and therefore the resolution of the grid) is 
displayed in the ‘X Grid Dimension’ and ‘Y Grid Dimension’ fields of the dialog box. The higher 
the resolution of the grid, the better the topographical features of the map will be resolved.  In 
general the resolution should be set so that the individual cells are not greater than the smallest 
topographical feature you want to resolve.  However, it is important to remember the resolution 
of the source data.  If you choose to create an elevation file that has a higher resolution than the 
input data, the program will be forced to interpolate to the higher resolution.  This could add a 
significant source of error to the process. 

For example, if the study area covers relatively flat terrain (for instance, the Great Plains), there 
are few topographical features and increasing the grid resolution will provide little increase in 
accuracy.  If, on the other hand, the study area covers some extreme terrain (the Grand Canyon 
for instance), a difference in 100 feet could result in a change in elevation of several thousand feet. 

You may edit either the number of grid points or the size of each grid cell.  However, only one 
element can be changed.  The other elements are updated automatically by moving the mouse off 
of the dialog.  By default the number of grid points is editable initially.  This can be changed by 
clicking the long bar just beneath grid dimension fields.  This changes the editable parameters, 
allowing you to choose the dimensions rather than the number. 

When the dimension is chosen as the editable parameter, the computer will round the dimension 
down to reach an integer number of grid points to fit the area.  For example, if the study area is 
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50,000 feet across, and you choose a nominal X grid dimension of 30 feet, you will end up with an 
actual grid dimension of 29.994 feet and 1668 grid points (see Figure 3-4). 

3.2.3.1.1.3 Reference Points 

The final element of this dialog box is the lower section called ‘Reference Points’.  This section is 
important for users who want to see values in a different coordinate system (one other than 
Lat/Long or UTM).  For example, if you have a paper map of the study area listed in State Plane 
coordinates (a local coordinate system used by many states) it is possible to set up NMSim do 
display these coordinates as well.  The reference point will be used to link this alternate reference 
coordinate system to the native UTM 84 coordinate system of the elevation file. 

This reference point is located on one of the grid points as shown in the fields ‘X Grid Point’ and 
‘Y Grid Point’, and is displayed inside of the study area with the ‘+’ sign.  Changing the grid 
point values of the reference point changes the location of the reference point, and pressing 
‘Redraw’ will update the map. 

It is also possible to select the location of the reference point directly by entering its location into 
the coordinate fields below the grid location.  As with the grid resolution, you must first click the 
large bar below these fields to unlock them.  Entering a coordinate directly will only provide a 
nominal location since the reference point must be collocated with one of the grid points.  Once 
the mouse is moved off of the dialog these coordinates will be updated automatically to the 
nearest grid point.  If a specific reference coordinate is desired, it is up to the user to design the 
study area and grid size such that a grid point will lie exactly at that location. 

Once you are satisfied with the study area, selecting the menu item ‘Open -> Save Elevation File’ 
allows you to save the Elevation file.  You will then be asked if you want to add a different user 
coordinate system.  If you choose ‘Yes’ you may enter data about the new coordinate system 
through the dialog shown in Figure 3-1. 
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3.2.3.2 User-Defined Coordinates 

 

Figure 3-5. User-Defined Coordinates Dialog 

In the upper portion of the dialog is shown the UTM coordinates of the reference point.  This is 
un-editable here and must be changed in the main dialog as described above.  Below the 
coordinate system reference point are fields where you can enter data about the reference point.  
A new user defined coordinate for the reference point can be entered in either feet or meters.  You 
may also rotate the new coordinate system relative to the base UTM system shown in the map by 
entering a value in the rotation field. 

For example, if you want data to be shown in State Plane coordinates, first you must know what 
the reference point coordinate is in the State Plane system, and then you must know how the 
state plane system is rotated to the UTM zone at that point.  If this data is entered correctly into 
the User Coordinates dialog shown in Figure 3-5 then the correct State Plane coordinates will be 
displayed throughout NMSim. 

Whether or not you chose to define a user coordinate system, you will now be asked to select an 
elevation file name.  Once a file name is selected, the elevation file will be generated.  When the 
program is finished making the file it will signal you with a ‘Finished!’ dialog.  After successfully 
building an Elevation file the computer will prompt you if you want to build an Impedance file. 

3.2.4 Editing an Existing Elevation File 

After an elevation file is built, a sister file is also built with an ‘*.elb’ extension.  This is the 
Elevation build file and allows you to edit an existing Elevation file.  If you decide to move the 
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elevation file to a new location it is important to move the build file as well.  If no build file is 
found, the program will revert to building a new case. 

If the Elevation file field in the NMSim File Loading/Building Dialog shown in Figure 3-1 is filled 
in, pressing the ‘Build/Edit Elevation and/or Impedance File’ button will launch the Elevation 
file builder.  Alternatively, once the Elevation builder has been launched, you can select the menu 
item ‘File  Open’.  This will bring up a standard windows file select dialog.  You then need to 
select the elevation file (*.elv) you want to edit.  In either case, the Elevation File Case Building 
dialog shown in Figure 3-2 will appear and be automatically populated with the files used to 
build the original Elevation file.   

You can change the input files here, or accept the original set and continue by pressing the 
‘Finished’ button.  The Elevation file builder will reprocess the files and bring up the Elevation 
Builder Main Screen shown in Figure 3-3.  This time, however, the study area and all settings are 
automatically set.  Changes can be made exactly the same as if a new case were being generated. 

3 . 3  I m p e d a n c e  F i l e s  

Impedance files store information about the ground impedance of the study area in a grid 
identical in size and resolution to the elevation grid.  In NMSim, the ground impedance is 
quantified by the flow resistivity (in MKS RAYLS) of the ground.  The better the ground is at 
reflecting the sound the higher the impedance and flow resistivity.  For example, asphalt is 
acoustically very hard and has a resistivity of about 30,000 RAYLs (Pa·s/m).  Table 3-2 lists some 
typical impedance values. 

Table 3-2. Typical Flow Resistivity Values7 

Ground Cover Flow resistivity (RAYLS) 

Snow Covered Ground 30 
Forest Floor 50 
Grassy Field 225 
Roadside Dirt 650 
Packed Sand 1650 
Hard Packed Dirt 3000 
Exposed Dirt/Rock 6000 
Asphalt 30000 
Water 100000 

The effect of impedance on sound propagation can be significant.  From a heuristic viewpoint, 
everyone knows how much quieter it is on a snow covered day.  From a more practical point of 
view, changing impedance from 200 RAYLs to 100,000 RAYLs could impact the noise at a 
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receiver by as much as 20 dBA.  For this reason it is important to accurately represent the ground 
cover with the correct impedance. 

3.3.1 Building a New Impedance File 

You are given the option to build a new Impedance file after you have successfully built an 
Elevation file, or by selecting the menu option ‘File -> Save Impedance File’ (provided that a 
legitimate elevation file exists).  After an introduction message the dialog shown in Figure 3-6 
will appear: 

 

Figure 3-6. Impedance File Build Dialog 

The Impedance file builder allows you to select DLG hydrography files to determine where the 
water is.  This is important since water generally has much higher impedance than the ground.  
You should select the DLG hydrography files that will cover the study area.  If you do not want 
to designate a set of water files, the entire study area will be considered Soft (ground). 

After the hydrography files have been selected, you should ensure that the impedance values are 
correct.  Generally speaking, 100,000 RAYLs is appropriate for water. For appropriate values of 
soft (ground) impedance, you can get a copy of Typical Acoustic Impedance Values table on the 
screen by pressing the ‘Examples’ button.  This will bring up the following dialog: 
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Figure 3-7. Impedance Value Examples 

You can select one of the typical values to automatically update the Impedance file-building 
dialog. 

After the DLG hydrography files have been selected and the correct impedance values for Hard 
(water) and Soft (ground) conditions have been set, clicking the ‘OK’ button will bring up a file 
name selection.  After you select a file name the program will build a new Impedance file, 
followed by a ‘Finished!’ dialog when it is complete. 

3.3.2 Editing an Existing Impedance File 

This process is the same as editing an existing Elevation file, up until the study area is shown in 
the screen (see Section 3.2.4).  At this point you may select ‘File -> Save Impedance File’ from the 
menu, and follow the direction for generating a new Impedance file in Section 3.3.1. 

3 . 4  B a c k g r o u n d  L a y e r  F i l e s  

The background layer file is a graphics file that overlays the contour map.  It can show you 
almost any feature that has a descriptive file.  NMSim will accept either DLG files or ESRI 
shapefiles as input, but before a layer can be added the correct input files must be collected.  If 
DLG files will be used, see the DLG Category names and abbreviations table for a description of 
the files.  All file types except the Hypsography (HP) files can be used in creating the layer file 
(see Table 3-1 for a description of the files). 

If ESRI shapefiles are to be used it is up to you to ensure that the files store data in UTM 84 
coordinates with the same zone as the Elevation file.  This is because the shapefiles do not contain 
any information about the coordinate system used to generate them.  If any of the defining 
coordinates of the shape file are different from the Elevation file than the layer will not be drawn 
correctly. 



  
N o i s e  M o d e l  S i m u l a t i o n  ( N M S i m )  

U s e r ’ s  M a n u a l  
 
 
 

 

   3-19

  June 2005 
  WR 03-09 

Shapefiles usually come with a number of support files, but none of them are needed to draw the 
layer.  Only the ‘*.shp’ file is used. 

3.4.1 Building a New Layer File 

To begin building a new Layer file you should bring up the NMSim File Loading/Building 
dialog shown in Figure 3-1 by selecting the menu item ‘Edit’.  Then you should press the 
‘Build/Edit Layer File’ button.  This will bring up the dialog shown in Figure 3-8.  This dialog 
allows you to select both DLG files and Shapefiles to add to the background layer. 

 

Figure 3-8. Background Layer Building Dialog 

 

3.4.1.1 Adding DLG Layer Files 

To add DLG Layer files you must first ensure that all of the DLG files that will go into the layer 
are in the same directory.  Pressing the ‘Browse for DLGs’ button shown in Figure 3-8 allows you 
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to browse to that directory.  When the correct directory has been selected, NMSim will 
automatically identify the various DLG layers by the two letter abbreviations in their file name 
(see Section 3.2.1.1).  If you alter the file names and eliminate the two-letter abbreviation, NMSim 
will not be able to correctly identify the various files. 

To add these files to the background layer you must select each file in the list.  Selected files will 
be highlighted in blue.  A different color may be selected for each kind of DLG file by pressing 
the ‘Change Color’ button.  The selected color will then show up in the swatch square next to that 
button. 

For the ‘Roads and Trails’ layer, you have the ability to select how detailed the layer should be.  
For example, an area in a large city will have a large number of ‘Neighborhood Streets’.  Adding 
these in might make the map so cluttered that it becomes unintelligible.  Similarly, in some rural 
areas there might be nothing but trails and dirt roads, so it would be important to select them. 

After all of the desired DLG files have been selected, press ‘OK’ to continue or press the ‘Add a 
Shapefile (*.shp)’ button (see Section 3.4.1.2).  Pressing ‘OK’ will bring up a file name selection 
dialog followed by a ‘Finished!’ message announcing that the layer file has been built.  You are 
then asked if you would like to store the current color set for the DLGs as the default.  This way 
you can save the color scheme for each of the DLG layers so that the next time a layer file is built 
it will use the same colors. 

3.4.1.2 Adding a Shapefile 

To add a shapefile, press the ‘Add a Shapefile (*.shp)’ button.  This will bring up a file-selecting 
dialog asking you to locate the shapefile.  Once the file has been selected the dialog shown in 
Figure 3-9 will appear: 

 

Figure 3-9. Shapefile Dialog 

This is the basic dialog for controlling how the shapefiles will be drawn on the screen as part of 
the Layer.  To change the color of this layer, press the ‘Change Color’ button.  After selecting an 
appropriate color the new layer color will appear in the swatch square next to the button. 

After all of the desired shapefiles have been selected, press ‘OK’ to continue or press the ‘Browse 
for DLGs’ button (see Section 3.4.1.1).  Pressing ‘OK’ will bring up a file name selection dialog 
followed by a ‘Finished!’ message announcing that the layer file has been built.  The Layer file is 
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saved with the ‘*.mrk’ extension.  After a Layer file is built, a sister file is also built with a ‘*.mrb’ 
extension.  This is the Layer build file and allows you to go back and edit an existing Layer file. 

After the Layer file is built you have the option to store the current color set as the default.  This 
way you can save the color scheme for the DLG layers so that the next time a layer file is built 
from scratch it will use the same colors.  The shape files will always come up with the default 
black color. 

3.4.2 Editing an Existing Layer File 

If the Layer file listed in the NMSim File Loading/Building Dialog (shown in Figure 3-1) is filled 
in, pressing the ‘Build/Edit Layer File’ button will launch the Layer file builder and will bring up 
the dialog shown in Figure 3-8, along with dialogs with all of the Shapefiles used to generate the 
Layer file.  This dialog will automatically be populated with the files and colors used to build the 
original Layer file, provided that the build file is in the same directory as the Layer file.  If you 
moved the Layer file to a new location it is important to move the build file as well.  If no build 
file is found, the program will revert to building a new case. 

The build file stores the list of shapefiles and their associated colors, as well as the DLG directory 
and the colors of all of the DLG categories.  It also stores which ‘slots’ were selected in the 
Background Layer Building dialog (Figure 3-8), but not the exact file names.  Therefore, if the files 
in the DLG directory have changed, it is possible that the computer will select (highlight) a 
different set of files from the original case.  For example, if file the third file from the top was 
originally selected from the ‘Roads and Trails’ category, but additional files were added to the 
DLG directory since the original build, the third file from the top will still be selected for the 
rebuild regardless of the file name. 

Once the case has reloaded, make any changes just as if you were building a new Background 
Layer file (see Section 3.4.1). 

3 . 5  R e c e i v e r  S i t e  F i l e s  

The receiver site file allows you to get noise levels at specific locations and specific heights off the 
ground while running NMSim.  You may elect to place measurement points anywhere within the 
study area at any given height off of the ground.  The receiver site file, however, is an optional 
file.  NMSim will automatically assign the Reference Point (see Section 3.2.3.1.1.3) as a surrogate 
receiver site with a height of four (4) feet if specific receiver site file is not selected. 
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3.5.1 Adding a New Receiver Site File 

To build a new Receiver Site File, press the ‘Build/Edit Receiver File’ button on the NMSim File 
Loading/Building Dialog shown in Figure 3-1.  Provided that the current Elevation file is valid, 
this will bring up the window shown in Figure 3-10: 

 

Figure 3-10. Receiver Site Builder Main Screen 

If the Elevation file is invalid, the program will launch with a blank screen.  In this case, select 
‘File -> New’ where the program will ask for a valid elevation file. 

For this example, the elevation file FortTi.elv and the Background Layer file FortTi.mrk were 
used to generate the map and layers shown in Figure 3-10.  These files are supplied with the 
installation in the FortTiCase folder (see Section 2.1). 

On the bottom of the screen are the coordinates of the cursor in Lat/Long, UTM, and the user-
defined coordinate system (if it is present), as well as the altitude of the cursor location in feet.  To 
place a new receiver site on the map, position the cursor where the new site should be and press 
the right mouse button.  You will be presented with a pop-up menu with ‘Add Site’ and ‘Cancel’.  
To add the site either select ‘Add Site’ or press ‘A’, and a new site will appear on the map at the 
cursor position.  The new site is drawn as an unfilled red circle with a smaller, filled circle inside.  
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When the new site is added a dialog also appears on the upper right of the screen (shown in 
Figure 3-11) that describes the meter site. 

 

Figure 3-11. Receiver Site Dialog 

To add a site name, enter it in the appropriate field.  The site height and the position can also be 
changed.  If coordinates of the site are changed in this dialog pressing the ‘Redraw’ button will 
update the position of the receiver site on the screen.  Clicking on ‘Delete’ will remove the site.  
Adding additional sites also adds additional dialogs, up to a maximum of 100 receiver sites.  
Note that the windows system is only capable of displaying 50 dialogs at a time, so after the first 
50 sites have been selected no new dialogs will appear.  Instead, the last dialog (number 50) will 
update with the new information.  These dialogs may be moved around on the screen to make it 
easier to keep track of them. 

The default coordinate system for displaying the receiver site coordinates is UTM.  If you prefer 
to see the location in either a geographic (Lat/Long) coordinate system or the user-defined 
coordinate system (see Section 3.2.3.2), select the ‘View -> Lat/Long’ and ‘View -> User Defined’ 
menu items.  Changing the coordinate system will automatically update all of the dialogs. 

The menu item ‘View -> Refresh Sites’ is used if the screen becomes too cluttered with the 
dialogs.  It will realign all of the dialogs to their original positions and redraw all of the sites to 
the coordinate listed in the dialogs. 

To select a specific receiver site, either left-click on the circle representing that site, select the site 
from the pull down menu ‘Sites’, or select the associated dialog.  Changes can then be made to 
the name, the height, or the location.  To delete a receiver site, either right-click on the circle 
representing that site and select ‘Delete’ from the pop-up menu or click on the ‘Delete’ button on 
the associated dialog. 

Once you have finished placing the receiver sites, save the Receiver Site file by selecting ‘File -> 
Save Site File’.  This will bring up the standard widows save dialog.  The file is saved with the 
‘*.sit’ extension.  No companion build files are generated with the Receiver Site file. 
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3.5.2 Editing an Existing Receiver Site File 

If the Receiver Site file listed in the NMSim File Loading/Building Dialog (shown in Figure 3-1) is 
filled in, pressing the ‘Build/Edit Receiver File’ button will launch the Receiver Site file builder 
and will bring up the contour map and receiver sites (along with their associated dialogs).  
Alternatively, once the Receiver Site builder has been launched, select the menu item ‘File -> 
Open’.  This will bring up a standard windows file select dialog.  You can then select the site file 
(*.sit) you want to edit. 

This allows changes to be made to the file in exactly the same way a new file is built.  Sites can be 
added, moved, renamed, or deleted.  If the Receiver Site file listed in the NMSim File 
Loading/Building Dialog does not exist then the system will revert to building a new case.  
When the changes to the receiver sites are complete, save the file by selecting ‘File -> Save Site 
File’.  This will bring up the standard widows save dialog.  The file is saved with the ‘*.sit’ 
extension.  No build files are generated with the Receiver Site file. 

3 . 6  T r a j e c t o r y  F i l e s  

The Trajectory files define the full time history of a noise source.  It defines the heading, speed, 
climb angle, roll angle, power setting, and three-dimensional position for the source at each time 
interval of the study.  This data is then used to determine the state of the given noise source. 

The Trajectory files themselves are generic.  They contain no information about the source.  This 
makes it possible to use a single Trajectory File with multiple sources.  For example, if a trajectory 
is defined for a bus moving along a road, the same Trajectory File can be used with a car, a 
motorcycle, or even a Boeing 747 as the source.  The Trajectory File simply contains the 
information about how a source moves through space, including its altitude.  It is up to the user 
to ensure that the correct source is used with the Trajectory File since the source files contain no 
information about appropriate altitudes. 

The Trajectory File also contains the temperature and the relative humidity of the air for each 
case.  The relationship between the temperature/humidity and the absorption of sound is 
complex and you should use reasonable local values of temperature and humidity.  In general, 
the drier the air, the more sound will be absorbed by the atmosphere8,9.  The program will default 
to the standard atmosphere values of 59° F and 70% relative humidity. 

3.6.1 Building a New Trajectory File 

There are two types of Trajectory files a user can build: a flight Trajectory File and a ground 
Trajectory File.  They are functionally identical and can be interchanged.  They only differ in the 
methods used to create them.  In the Trajectory File section of the NMSim File Loading/Building 
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dialog (see Figure 3-1) there are two buttons for building these files; one labeled ‘Build/Edit 
Ground Track’ and one labeled ‘Build/Edit Flight Track’.  For sources that will stay on the 
ground (taxiing aircraft, trains, buses, etc.) the Ground Track button will allow you to easily 
generate the appropriate Trajectory File.  Likewise, the Flight Track button will allow you to 
design and build an aircrafts’ flight path and store this as a Trajectory File. 

3.6.1.1 Building a Ground Trajectory File 

To build a new Ground Trajectory File, press the ‘Build/Edit Ground Track’ button on the 
NMSim File Loading/Building Dialog shown in Figure 3-1.  Provided that the current Elevation 
file is valid, this will bring up the window shown in Figure 3-12: 

 

Figure 3-12. Ground Track Builder Main Screen 

If the Elevation file is invalid, the program will launch with a dialog stating that the build file was 
not found followed by a blank screen.  Then select ‘File -> New’ where you will be asked for a 
valid elevation file. 

For this example, the elevation file FortTi.elv and the Background Layer file FortTi.mrk were 
used to generate the map and layers shown in Figure 3-12.  These files are supplied with the 
installation in the FortTiCase folder (see Section 2.1). 
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On the bottom of the screen are the coordinates of the cursor in Lat/Long, UTM, and the user-
defined coordinate system (if present), as well as the altitude of the cursor location in feet.   

To begin the ground track, position the cursor at the desired location on the map and click the 
right mouse button.  A popup menu will offer the choices of ‘Add Segment’ and ‘Cancel’.  
Selecting ‘Add Segment’ (or simply press the ‘A’ key) will place an ‘X’ with a circle around it at 
the desired location and a dialog box (shown in Figure 3-13) will appear in the upper right of the 
window. 

 

Figure 3-13. Ground Track Segment Dialog 

This dialog contains all of the key information about this segment of the ground track.  The 
coordinates are shown on the top, and the speed at this point and the source height are shown on 
the bottom.  The ground track is created by joining all of these segments together with straight 
lines.  The vehicle velocities are linearly interpolated between each segment point. 

The source height should generally be constant for this type of track since the vehicle never 
leaves the ground.  The source height is there to represent where the centroid of the noise 
generation is located.   For example, the noise from a car is a combination of the engine noise 
(~2 feet above ground) and the tire noise (at the ground level). 

The default coordinate system for displaying the segment coordinates is UTM.  If you prefer to 
see the segment in either a geographic (Lat/Long) coordinate system, or with the user-defined 
coordinate system (see Section 3.2.3.2), select the ‘View -> Lat/Long’ and ‘View -> User Defined’ 
menu items. 

To select a specific segment, either left-click on the circle representing that site or select the site 
from the pull down menu ‘Sites’.  Changes can then be made to the source height, velocity, or the 
location.  To redraw the site after the changes have been made press the ‘Redraw’ button on the 
associated dialog. 
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To delete a segment, either click on the ‘Delete’ button on the associated dialog or right click on 
the ‘X’ and select ‘Delete Segment’ from the pull down menu that appears.  This will bring up 
another dialog offering the choice of deleting only this segment or this and every segment after it.  
This allows segments in the middle of the track to be removed without having to recreate the 
entire track. 

When you are satisfied with the ground track, select ‘File -> Write Trajectory File’.  You are asked 
to give a time step for the track file.  This time step is the even time increments used to generate 
the Trajectory File.  The program will then ask for the relative humidity in percent and 
temperature in degrees Fahrenheit for this case.  Finally, the standard windows save dialog will 
appear to select a file name.   This will save the Trajectory File with the extension ‘*.trj.’ 

3.6.1.2 Editing an Existing Ground Trajectory File 

After a Trajectory File is built using the Ground Track builder, a sister file is also built with a 
‘*.trg’ extension.  This is the Ground Track build file and allows you to edit an existing Ground 
Track file.  If you decide to move the Trajectory File to a new location on the computer, it is 
important to move the build file as well.  If no build file is found, the program will revert to 
building a new case. 

If the Trajectory File field in the NMSim File Loading/Building Dialog shown in Figure 3-1 is 
filled in, pressing the ‘Build/Edit Ground Track’ button will launch the Ground Track builder.  
This will bring up the screen shown in Figure 3-12, along with all of the track segments and their 
associated dialogs, exactly as they were left when the Trajectory File was originally built.  
Alternatively, once the Ground Track builder has been launched, select the menu item ‘File -> 
Open’ to will bring up a standard windows file select dialog.  Then select the build (*.trg) file to 
be edited. 

Changes to the segments are made in exactly the same manner as for building a new case.  When 
the changes are completed, the new Trajectory File can be saved the same as before.  
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3.6.1.3 Building a Flight Trajectory File 

To build a new Flight Trajectory File, press the ‘Build/Edit Flight Track’ button on the NMSim 
File Loading/Building Dialog shown in Figure 3-1.  Provided that the current Elevation file is 
valid, this will bring up the window shown in Figure 3-14: 

 

Figure 3-14. Flight Track Builder Main Screen 

If the Elevation file is invalid, the program will launch with a blank screen.  Then select ‘File -> 
New’ where you will be asked for a valid elevation file. 

For this example, the elevation file FortTi.elv and the Background Layer file FortTi.mrk were 
used to generate the map and layers shown in Figure 3-12.  These files are supplied with the 
installation in the FortTiCase folder (see Section 3.7). 

On the bottom of the screen are the coordinates of the cursor in Lat/Long, UTM, and the user-
defined coordinate system (if it is present), as well as the altitude of the cursor location in feet.   

To begin the flight track, position the cursor at the desired starting location on the map and click 
the right mouse button.  A popup menu will offer the choices of ‘Start Track Here’ and ‘Cancel’.  
Selecting ‘Start Track Here’ will place a hollow black box with a filled red circle inside at the 
desired location and a dialog box (shown in Figure 3-15) will appear in the upper right of the 
window. 
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Figure 3-15. Flight Track Initial Point Dialog 

This dialog box is labeled ‘Initial Point’ and represents the starting place for the flight track.  
Inside the dialog are fields for the altitude, heading, speed, power, and coordinates for the 
aircraft.  The default values for these fields are already in place and must be altered to get the 
desired flight conditions for the aircraft in your study. 

The altitude is represented in both feet MSL and AGL, with the AGL value editable.  The power 
setting for the aircraft is represented as a percentage.  The value this represents has different 
properties for the different aircraft (see Section 3.7). 

It is important to set the correct initial flight conditions for the track, so make sure all values have 
their proper settings.  For example, with the ‘ForTiFlight.trj’ file from the example case the 
aircraft in question starts off with a heading of 39 degrees (see Figure 3-15).  This was changed 
from the default value of 0 degrees.  To alter the coordinates of the starting point, enter the new 
coordinates into the appropriate fields and select ‘Redraw’ to refresh the screen.   

The default coordinate system for displaying the flight track coordinates is UTM.  To see the 
location in either a geographic (Lat/Long) coordinate system, or with the user-defined coordinate 
system (see Section 3.2.3.2), select the ‘View -> Lat/Long’ and ‘View -> User Defined’ menu 
items.  Changing the coordinate system will automatically update all of the dialogs. 

Now that the initial point has been set you can add additional flight segments by pressing the 
appropriate buttons on the tool bar at the top of the window.  The buttons will add either a 

straight flight track segment , or a curved flight track segment .  The complete flight 
track is made up of any combination of curved and straight segments.  The final flight trajectory 
will link all of the segments into a complete flight path. 
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As segments are added, a black line is drawn on the map representing each segment of the flight 
track.  At the end of each segment (either curved or straight) there is a black circle. A circle is 
filled in red if it is the currently selected segment.  By default, the last segment added is 
automatically selected as the current segment.  The conditions defining that segment represent 
the end point conditions.  The starting conditions for that segment are the ending conditions for 
the previous segment.  The velocities and altitudes are linearly interpolated between segment 
points, while the power setting will only be changed at the segment point.  The Flight Track 
builder will automatically calculate the roll and climb angles necessary to achieve the requested 
flight path. 

3.6.1.3.1 Adding a Straight Flight Track Segment 

To add a straight flight track segment to the case, click the straight flight track button .  This 
will add a red line to the map, starting at the currently selected segment point and going in its 
direction, ending in a red filled circle.  A ‘Straight Segment’ dialog (shown in Figure 3-16) will 
also appear.  If the last selected segment was the initial point then the straight segment will head 
in the direction set with the ‘Initial Point’ dialog shown in Figure 3-15.  If the last selected 
segment was straight, this segment will follow the same direction.  If the last selected segment 
was curved, this segment will leave tangent to the last point of the curved segment. 

 

Figure 3-16. Straight Flight Track Segment Dialog 

The segment is initially added with a length of 10,000 feet.  The power setting, airspeed, and MSL 
altitude are all the same as the last segment.  If, however, this would put the aircraft into the 
ground, the Flight Track builder changes the altitude to ground level.  If the distance of the 
segment is changed, press the ‘Redraw’ button to see the changes take effect.  The actual 
coordinates of this segment are not editable.  Rather, the end position is calculated from the last 
segment end point, the heading, and the distance. 
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3.6.1.3.2 Adding a Curved Flight Track Segment 

To add a curved flight track segment to the case, click in the curved flight track button .  
This will add a red curved line to the map, starting at the last selected segment point and 
continuing around to cover a positive 90 degree arc, ending in a red filled circle ( a turn to the left 
needs a negative number for the ‘Degrees of Arc’).  A ‘Curved Segment’ dialog (shown in Figure 
3-17) will also appear.  If the last selected segment was the initial point then the curved segment 
will start off heading in the direction set with the ‘Initial Point’ dialog shown in Figure 3-15.  If 
the last selected segment was straight, this segment will initially follow the same direction.  If the 
last selected segment was curved, this segment will leave tangent to the last point of the curved 
segment. 

 

Figure 3-17. Curved Flight Track Segment Dialog 

The segment is initially added with a Radius Of Curvature (ROC) of 10,000 feet and a 90-degree 
right turn (Degree of Arc = 90).  The power setting, airspeed, and MSL altitude are all the same as 
the last segment.  If, however, this would put the aircraft into the ground, the Flight Track 
builder changes the altitude to ground level.  If the distance of the segment is changed, press the 
‘Redraw’ button to see the changes take effect.  To make a left turn, change the Degree of Arc to a 
negative number.  The actual coordinates of this segment are not editable.  Rather, the end 
position is calculated from the last segment end point, the Radius of Curvature, and the Degrees 
of Arc. 

3.6.1.3.3 Adjusting a Flight Trajectory 

To select a segment you can either left click the mouse inside of the circle representing the end 
point, or use the pull down menu ‘Segments’ to select it.  If you make changes to any segment in 
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the middle of the flight track and press ‘Redraw’, the entire flight track from that point forward 
will be redrawn. 

If you add a segment in the middle of the track it will be inserted after the selected track and all 
following segments will be incremented by one.  If you choose to delete a segment from the 
middle of the flight track you will be given the choice of deleting all the following segments, or 
simply remove the selected segment.  If you choose to remove only the selected segments, all of 
the remaining segments will be decremented by one. 

The segment dialogs may be moved to any place on the screen for easy viewing.  The menu item 
‘View -> Refresh Segments’ is used if the screen becomes too cluttered with the dialogs.  It will 
realign all of the dialogs to their original positions and redraw all of the sites to the coordinate 
listed in the dialogs. 

If the flight track needs to pass over a specific location it may require iteration to line it up 
correctly.  Adjusting the initial heading, the total degrees of arc of each turn, and the distance and 
radius of curvature for each segment allows the flight track to be moved anywhere. 

It is important while building a flight trajectory to keep in mind the aircraft that will be used.  For 
example, it is unlikely that a Cessna 182 will fly at 1000 knots while making a tight turn.  
Similarly, a Boeing 747 will not be taking off the ground at only 70 knots.  Appendix B has a list 
of aircraft and general specifications that can be used for reference. In general, however, flight 
information must be obtained from a knowledgeable source such as the aircraft operator or the 
FAA. 

When you are satisfied with the flight track, select ‘File -> Write Trajectory File’.  The program 
will ask for a time step for the track file.  This time step is the even time increments used to 
generate the Trajectory File.  The program will then ask for the relative humidity in percent and 
temperature in degrees Fahrenheit for this case.  Finally, the standard windows save dialog will 
appear prompting you to select a file name.   This will save the Trajectory File with the extension 
‘*.trj.’ 

3.6.1.4 Editing an Existing Flight Trajectory File 

After a Trajectory File is built using the Flight Track builder, a sister file is also built with an ‘*.trf‘ 
extension.  This is the Flight Track build file and allows you to edit an existing Elevation file.  If 
you decide to move the Trajectory File to a new location on the computer, it is important to move 
the build file as well.  If no build file is found, the program will revert to building a new case. 

If the Trajectory File field in the NMSim File Loading/Building Dialog shown in Figure 3-1 is 
filled in, pressing the ‘Build/Edit Flight Track’ button will launch the Flight Track builder.  This 
will bring up the screen shown in Figure 3-14, along with all of the track segments and their 
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associated dialogs, exactly as they were left when the Trajectory File was originally built.  
Alternatively, once the Flight Track builder has been launched, select the menu item ‘File -> 
Open’.  This will bring up a standard windows file select dialog to select the build (*.trf) file to 
edit. 

Make any changes to the segments exactly the same as for building a new case.  When the 
changes are complete, the new Trajectory File can be saved the same as before.  

3 . 7  S o u r c e  F i l e s  

The source file serves as an index for a set of files that together define the noise source.  These 
files define the 1/3 octave band spectra for the aircraft.  The levels for the aircraft are definable 
over a full hemisphere and vary with certain vehicle specific parameters.  For example, the noise 
for a locomotive is dependent on the incline angle of the track while the noise source for the 
Boeing 747 is based upon the thrust of the engine.  The exact metric for each source is defined in 
the source file itself. 

Each source file (*.src) has associated with it several noise files with the suffix ‘*.avg’.  These files 
must be in the same directory (preferable in the ‘Sources’ directory) to function properly.  When a 
new source file is selected, a brief description of that source is given in the ‘Source Info’ field.  
That field is not editable and is only used for information purposes. 

There are several different types of sources available, each in a subdirectory in the ‘Sources’ 
folder.  For a complete list of all of the supplied sources, along with a brief description, please see 
Appendix C.  What follows is a brief synopsis of the different source types. 

 Air Tour Fixed Wing Sources:  These sources are based on measurements made by the 
FAA during the joint NPS-FAA Grand Canyon Model Validation project in 1999.  
Since the aircraft operated at a constant throttle setting and speed during those flights, 
these noise sources do not vary with any of the given parameters. 

 Air Tour Helicopter Sources:  These sources are based on measurements made by the 
FAA during the Grand Canyon Model Validation project in 1999.  Since the helicopters 
operated at a constant throttle setting and speed during those flights, these noise 
sources do not vary with any of the given parameters.  While this is an over 
simplification, the complexity required to fully address helicopter noise sources (as  
used in the Wyle/NASA Rotorcraft Noise Model10) is outside of the scope of the 
current model. 

 Ground Sources:  These are all of the car, bus, truck, motorcycle and train sources.  
They can be broken down to two main categories.  The automobile sources all estimate 
the noise level based on the speed of the vehicle.  The train source estimates the noise 
level based on the incline of the track. 
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 Integrated Noise Model Converted Sources:  These sources were compiled based 
upon the FAA’s INM spectral classes and INM’s ground attenuation algorithms.  The 
ground attenuation algorithms are used to determine the directivity pattern.  These 
sources vary with the given throttle setting.  In critical or controversial situations, 
more refined data should be sought. 

 Military Sources:  These are sources that Wyle Laboratories developed from original 
USAF flight test recordings.  Of all of the supplied sources, these are the most accurate. 

 Miscellaneous Sources:  This contains an omni directional source that varies with 
power setting.  It is similar to the source for a single engine propeller aircraft (and so 
uses that symbol).  It is useful for test purposes. 

3 . 8  A m b i e n t  N o i s e  F i l e s  

Ambient data is used by NMSim to calculate all of the Audibility metrics.  Depending on the case 
being run, the entire area can have a single ambient noise spectrum, or a map of spectra can be 
used.  In either case, you can access these spectra using the Ambient File Creator.  This will allow 
you to change the spectra, but it will not allow you to create a new ambient map.  That must be 
accomplished using third party GIS software capable of created ESRI ASCII grid files. 

3.8.1 Building or Editing an Ambient Noise File 

Whether you are using an ambient map or not, the process within NMSim is the same.  Simply 
press the ‘Build/Edit Ambient File’ button on the NMSim File Loading/Building Dialog.  If you 
are using a single spectrum, Section 3.8.2 applies.  If you are using an ambient map, Section 3.8.3 
applies. 
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3.8.2 Single Ambient Spectrum 

In cases where you are using a single ambient spectrum for the entire study area, the following 
dialog will appear: 

 

Figure 3-18. Single Ambient Spectrum Dialog 

For the example shown here, the ‘Coniferous.amb’ file was selected.  If no file is selected, all of 
the values listed in the Level (dB) column would be –99.9.  The values in the ‘Level (dB)’ column 
can be changed to suit whatever conditions are present for the current case.  If a specific spectrum 
is desired, simply enter the values in the appropriate rows.  Clicking on the ‘Recalculate 
A-Weight’ button will then give the updated A-Weighting for the selected spectrum.  To get a 
specific A-Weighted value, change the values listed in the ‘A-Weighted Value’ field and click the 
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‘Update Frequencies’ button.  This will recalculate the levels at all of the frequencies to give the 
desired A-Weighting.  The levels at all of the frequencies are shifted equally to achieve this result. 

The name at the top of the dialog is a description of the ambient environment.  This name cannot 
have any spaces in it.  However, if you put spaces in it, the program will change all the spaces to 
underscores when it saves the file. 

To save the resulting ambient levels, either click the ‘Save’ button, or select the menu item 
‘File -> Save’.  This will bring up the standard Windows file select dialog.  Clicking ‘Cancel’ or 
selecting the menu item ‘File -> Exit’ will exit from this dialog without saving any further 
changes.  To open an existing Ambient Noise file, select the menu item ‘File -> Open’ and follow 
the standard Windows file select dialog. 

Five pre-generated ambient spectra are supplied with the model.  The following table lists the 
spectra for each of the files supplied. 

Table 3-3. One-third Octave Band Ambient Levels for the Supplied Ambient Noise Files 

1/3 Octave Band Coniferous DesertScrub PinyonJuniper Quiet WaterRapids 

50 35.4 26.8 22.4 22.4 32.6 
63 34.7 27.1 22.9 22.9 28.6 
80 33.9 26.6 21.7 21.7 27.6 

100 31.2 23.7 19.9 19.9 28.6 
125 29.2 23.7 18.7 18.7 29.6 
160 26.9 22.1 14.7 14.7 30.6 
200 25.0 20.4 13.3 13.3 30.6 
250 27.8 18.2 13.1 13.1 28.6 
315 26.4 15.9 12.3 12.3 27.6 
400 26.3 13.2 10.6 10.6 26.6 
500 25.1 12.3 10.1 10.1 25.6 
630 24.0 10.8 8.8 8.8 24.6 
800 22.8 9.6 9.4 9.4 23.6 

1000 20.0 7.8 11.5 7.8 22.6 
1250 17.2 6.6 10.9 6.6 21.6 

1600 17.1 4.9 10.7 4.9 20.6 

2000 15.5 3.1 8.9 3.1 19.6 
2500 14.1 1.2 4.6 1.2 17.6 
3150 12.5 -0.6 4.9 -0.6 15.6 
4000 7.4 -1.6 -0.1 -1.6 13.6 
5000 4.5 -2.7 -2.0 -2.7 11.6 
6300 1.9 -3.5 -3.9 -3.9 9.6 
8000 0.6 -3.9 -5.5 -5.5 7.6 

10000 -0.4 -4.0 -4.6 -4.6 5.6 
A-Weight 30.9 20.0 19.9 17.6 32.8 

For more details about the Ambient Noise file, check Appendix A. 
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3.8.3 Ambient Spectra Map 

In cases where you are using an ambient map with multiple spectra for the study area, the 
following dialog will appear: 

 

Figure 3-19. Multiple Ambient Spectra Dialog 

The values in the ‘Level (dB)’ column can be changed to suit whatever conditions are present for 
the current case.  If a specific spectrum is desired, simply enter the values in the appropriate 
rows.  Clicking on the ‘Recalculate A-Weight’ button will then give the updated A-Weighting for 
the selected spectrum.  To get a specific A-Weighted value, change the values listed in the 
‘A-Weighted Value’ field and click the ‘Update Frequencies’ button.  This will recalculate the 
levels at all of the frequencies to give the desired A-Weighting.  The levels at all of the frequencies 
are shifted equally to achieve this result. 
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The name at the top of the dialog is a description of the ambient environment.  This name cannot 
have any spaces in it.  However, if you put spaces in it, the program will change all the spaces to 
underscores when it saves the file. 

To save the resulting ambient levels, either click the ‘Save’ button, or select the menu item 
‘File -> Save’.  This will bring up the standard Windows file select dialog.  Clicking ‘Cancel’ or 
selecting the menu item ‘File -> Exit’ will exit from this dialog without saving any further 
changes.  To open an existing Ambient Noise file, select the menu item ‘File -> Open’ and follow 
the standard Windows file select dialog. 

There are navigation arrows on the right hand side of the dialog with an index number above 
them.  This allows you to cycle through all of the ambient spectra for this case.  Also, the index 
number represents the index in the ambient map.  The menu item ‘Grid File’ allows you to type 
in the name of the ESRI ASCII grid file that stores the ambient map.  Note that the grid file must 
be in the same directory as the ambient noise file. 

3.8.3.1 Ambient Grid File 

The ambient grid file is an ESRI ASCII file that has index values as its data.  These index values 
should represent distinct ambient spectra for that location of the map.  This file can be created 
using any GIS software so long as it can save the resulting data in the ESRI ASCII format.  The 
indices should start at one (1) and move sequentially for as many different ambient values as 
there are.  

The Ambient Noise file is used as the index file.  Within that file there is an index associated with 
each of the ambient spectra.  By combining these two files NMSim is able to produce a detailed 
ambient noise map for doing its audibility calculations.  For more details about the Ambient 
Noise file, see Appendix A. 

3 . 9  R u n n i n g  N M S i m  

After a full set of files has been either selected or built using the NMSim File Loading/Building 
dialog (shown in Figure 3-1) you are ready to use NMSim to do single event noise analysis.  This 
example uses the Fort Ticonderoga files supplied with the installation in the FortTiCase folder 
(see Section 2.1).  Accepting the set of files will bring up the NMSim Interactive Analysis screen 
(Figure 3-21). 
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3.9.1 NMSim Interactive Analysis Screen 

 

Figure 3-20. NMSim Interactive Analysis Screen 

This window has a number of sections: 

 The main window shows the map of the study area with a number of map features: 
 The elevation contours drawn in gray. 
 The background layers drawn in the selected colors. 
 The receiver sites drawn in red. 
 The flight track drawn in magenta.  The aircraft follows this flight path. 
 An icon representing the vehicle in black.  A line connects the source used in this case 

to the currently selected receiver.  If no receiver sites were selected for this case, a 
default receiver site is placed at the reference point defined with the elevation file (see 
Section 3.2.3.1.1.3). 

 A display at the bottom of the window shows the coordinates and terrain elevation at 
the current mouse cursor position in Lat/Long, UTM, and the user-defined system. 

 Above the main window is a smaller window with three lines drawn and the word 
‘Soft’ to the right hand side.  The bottom crooked line (in black) shows the terrain 
elevation profile from the source to the receiver.  The next line up is straight and 
shows a direct line of sight from the source (on the left) to the receiver (on the right).   
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 If this line of sight is unobstructed, the line is gray.  If there is intervening terrain, the 
line-of-sight line is drawn in red.  This illustration is to the same scale as the map, and 
the altitude and distance scales are equal, so angles are properly represented.  A 
ground impedance profile (blue) at the top indicates whether ground is hard or soft as 
determined by the impedance file (described in Section 3.3). 

 Three dialog boxes described in the subsections below. 

3.9.1.1 Receiver Site Information 

The upper dialog is the Site Info dialog, and it is repeated in Figure 3-22.  This dialog gives 
information about the sound at the select receiver site. 

 

Figure 3-21. Receiver Site Information Dialog 

The following list describes the data in this dialog: 

 Site:  The name of the selected Receiver site.  If the receiver was not given a specific 
name, a default number is assigned based upon the order in which the receiver site 
was added. 

 A Level:  The A-Weighted sound level at the receiver. The propagation calculations 
are performed by Rasmussen’s full spectral method11 denoted ‘A-Level’. 

 Grd Eff:  The total A-Weighted attenuation of the sound due to the intervening 
terrain. 

 Model:  This is a note that explains which aspect of the propagation model dominates 
this attenuation.  The three possible values are: hill, valley, flat. 

 % Soft:  The percent of the propagation path that is over the ground (soft). 
 Dist:  The distance from the source to the receiver. 
 T Arr:  The arrival time for the sound.  This includes the propagation time from the 

source to the receiver and the total travel time of the source from the start of the 
trajectory. 
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This data is for information purposes only and is not editable. 

3.9.1.2 Trajectory Information 

The next dialog is the Track Info dialog, shown in Figure 3-23.  This dialog contains information 
about the source and the trajectory over which the source travels.  The following list describes 
data shown in Figure 3-23: 

 

Figure 3-22. Track Information Dialog 

 Time:  Elapsed time for this trajectory. 
 X Trk:  Easting position of the sources in UTM 84. 
 Y Trk:  Northing position of the source in UTM 84. 
 Z Trk:  Altitude of the source (MSL) in feet. 
 Head:  Compass bearing of the source in degrees. 
 Gamma:  The climb angle of the source in degrees. 
 Speed:  The speed of the source in knots. 
 Power:  The power setting of the source as referenced to the specific source (see 

Section 3.7 for details) 
 Z AGL:  The height of the source above the ground in feet. 
 ElAng:  The elevation angle between the source and the receiver in degrees. 
 Roll:  The roll angle of the vehicle in degrees. 
 Phi:  The angle, in the roll direction, from the source to the receiver. 
 Theta:  The angle from the source path direction to the receiver. 
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This data is for information purposes only and is not editable. 

3.9.1.3 Elevation Contours 

The final dialog is located in the lower right hand side of the window and is shown in Figure 
3-24.  This allows you to change the interval of the elevation contours drawn on the map.  In 
some instances it is helpful to increase or decrease these intervals.  For example, the Grand 
Canyon has a total elevation change of roughly 5000 feet.  If the contour intervals were drawn 
every 100 feet this would become too cluttered to be useful.  Similarly, zooming into some spot 
on the map (see Section 3.9.2.5) with elevation changes of less than 100 feet, it will be necessary to 
reduce the contour intervals to a point where some intervals will be shown.  The minimum level 
is 20-foot intervals.  Also, the system will not draw more than 100 contour intervals regardless of 
the selected value. 

 

Figure 3-23. Contour Interval Dialog 

3.9.2 NMSim Controls 

NMSim noise calculations are run through a combination of keyboard, mouse, and menu inputs.  
The following sections provide a description of the various ways to operate NMSim. 

3.9.2.1 Keyboard Controls 

The source vehicle can be moved along the track by pressing the up arrow key to move forward 
and the down arrow key to move backwards.  Pressing the control key (CTRL) in conjunction 
with the up or down arrow key will move the vehicle 10 time steps either forward or backwards. 

Different receiver sites can be selected by either left-clicking the mouse within the circle 
representing a given receiver, or cycle through the receiver sites with the Page-Up and Page-
Down key.  In addition, there are several analysis options that are accessible from the keyboard 
hotkeys.  Table 3-4 lists the main key commands available. 
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Table 3-4. NMSim Key Commands 

 

Up Arrow ......................................................................Move forward 1 time increment 

CTRL-Up Arrow...........................................................Move forward 10 time increments 

Down Arrow................................................................Move back 1 time increment 

CTRL-Down Arrow ....................................................Move back 10 time increments 

Home .............................................................................Move to first track point 

End..................................................................................Move to last track point 

PgUp...............................................................................Select next site 

PgDn...............................................................................Select prior site 

F1.....................................................................................Bring up the online help 

F2.....................................................................................Run a full grid case and generate all time histories for that case 

CTRL-V ...........................................................................Run a full grid and all of the receiver sites and launch the NMSim Visualizer 

F3.....................................................................................Run a full receiver set case and generate time histories for each receiver site 

F4.....................................................................................Move source through full track generating a time history for the current receiver, 
and bring up a plot 

Shift F4...........................................................................Generate a time history for the current receiver, and bring up a plot without the 
animation 

F5.....................................................................................Table of 1/3 octave band ground effect for receiver 

F6.....................................................................................Graph of 1/3 octave band ground effect for receiver 

F7.....................................................................................Table of spectrum for current source/receiver 

F8.....................................................................................Graph of spectrum for current source/receiver 

+.......................................................................................Zoom in 

- ........................................................................................Zoom out 

0.......................................................................................Zoom to original view 

 

There are several noise metrics that can be shown by either selecting the appropriate menu item 
from the ‘View’ menu list, or by pressing the appropriate buttons.  Selecting these metrics will 
open various windows that can be resized and/or moved however you please. 

3.9.2.2 Time Histories 

To see a time history of the noise at a given receiver, either select the menu item ‘View -> Time 
History w/Animation’ to see the vehicle move through its full trajectory, or ‘View -> Time 
History w/o Animation’ to skip the animation.  Alternatively, press function key 4 (F4) for the 
time history with the animation or press Shift F4 for the time history without the animation.  The 
result is a pop-up window with the graph of the time history, similar the graph shown in 
Figure 3-25. 
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Figure 3-24. NMSim Time History Graph 

In this graph the solid green line shows the flat weighted value of the noise while the dashed red 
line shows the A-Weighted value.  The x-axis shows time in seconds and the Y-axis shows the 
noise level in decibels.  Also shown on this graph are the Flat and A-Weighted Sound Equivalent 
Level (SEL) and the maximum A-Weight level reached during the time history.  If you want to 
print the graph, select the ‘Print’ menu item from the graph window. 

3.9.2.3  Ground Effects 

You may examine the effects of the ground on the noise at a specific receiver by examining either 
a graph of the effects or a table of the effects.  To look at the table, either select the menu item 
‘View -> Ground Effect Table’, or press the F5 key.  This will bring up a dialog similar to the one 
shown in Figure 3-26: 
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Figure 3-25. Ground Effect Table 

This table lists the amount of attenuation to the signal of each 1/3 octave band due to the 
intervening terrain.  If no impedance file was built for this case, the ground is assumed to be soft 
(200 RAYLS).  An alternative way to view this data is in a graph by selecting the menu item 
‘View -> Ground Effect Graph’ or by pressing the F6 key.  This would bring up a window similar 
to the one shown in Figure 3-27: 



  
N o i s e  M o d e l  S i m u l a t i o n  ( N M S i m )  

U s e r ’ s  M a n u a l  
 
 
 

 

   3-46

  June 2005 
  WR 03-09 

 

Figure 3-26. Ground Effect Graph 

In this graph the solid green line shows the attenuation to the noise signal.  The x-axis shows the 
third octave bands and the Y-axis shows the noise level in decibels.  As the vehicle moves along 
the trajectory, or if a different receiver site is selected, both of these windows will automatically 
update showing the spectra of effect for the specific source/receiver combination. If you want to 
print the graph, select the ‘Print’ menu item from the graph window. 

3.9.2.4 Receiver Spectra 

You may examine the spectra of the noise at the selected receiver site with either a table of noise 
levels or a graph.  To view the table, select the menu item ‘View -> Receiver Spectrum Table’, or 
press the F7 key.  This will bring up a dialog similar to the one shown in Figure 3-28: 
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Figure 3-27. Receiver Spectrum Table 

This table lists the actual noise level of each 1/3 octave band at the receiver.  The A-Weight value 
of this signal is what is displayed in the Site Info dialog shown in Figure 3-22.  View this data in a 
graph by selecting the menu item ‘View -> Receiver Spectrum Graph’, or by pressing the F8 key.  
This will bring up a window similar to the one shown in Figure 3-29: 
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Figure 3-28. Receiver Spectrum Graph 

In this graph the solid green line shows the spectrum of the signal with the ground attenuation 
added while the red dashed line shows the spectrum without the ground attenuation.  The x axis 
shows the third octave bands and the Y-axis shows the noise level in decibels.  As the vehicle 
moves along the trajectory, or if a different receiver site is selected, both of these windows will 
automatically update showing the spectrum of ground effect for the specific source/receiver 
combination. If you want to print the graph, select the ‘Print’ menu item from the graph window. 

3.9.2.5  Zoom Control 

Zoom into the map of NMSim with either the mouse or the keyboard.  For keyboard input, 
pressing the ‘+/=’ key will increase to zoom by 100%.  Similarly, pressing the ‘-/_’ key will zoom 
out 100%.  Pressing the ‘0’ key will bring the zoom back to the home view.  To use the mouse, 
click and drag a marquee over the area to be zoomed into.  This will zoom into that area as far as 
possible while still fitting everything in the screen.  There is a limited level of zoom available.  
Trying to zoom in farther than that causes an error chime to sound. 

3.9.3 NMSim Output 

There are three different kinds of output to choose from.  You can chose to output the time 
histories of the specific receiver sites only, output a full grid analysis of the study area, or both.  
The following sections describe these various output options. 
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3.9.3.1 Full Grid Output 

Selecting the menu item ‘Output -> Full Grid’ (or pressing the F2 key) will start the full grid 
output process.  First, a dialog (shown in Figure 3-30) will pop up asking you to select a full grid 
resolution.  This assigns the total number of grid points defining the study area. 

 

Figure 3-29. Full Grid Resolution Dialog 

The issue is a compromise between resolution and computation time.  The higher the resolution, 
the more computations and the longer it will take.  NMSim will need to do the full propagation 
calculation for every grid point and for every point along the trajectory.  For example, the Fort 
Ticonderoga case supplied with NMSim has 154 points in the trajectory.  At a resolution of 40 by 
40, this makes a total of 246400 calculations for the full grid.  On a 1GHz Pentium III computer, 
these calculations take roughly 10 minutes to process.  The resulting file size is 47.2 MB, or 
roughly 190 bytes per trajectory point per grid point. 

With this system you can select a resolution up to 99,999 grid points in the X direction by 99,999 
grid points in the Y direction, although the computational time for this could be prohibitive.  The 
default setting is 40 by 40, and this gives a good combination of resolution versus computation 
time.  Also, when the time comes to generate a video (see Section 4.1.3.1) this resolution produces 
adequate results.  If a precise noise level at a specific location is needed it is much better to place a 
receiver at that location and simply use the interface of NMSim to get the level rather than 
interpolate from the grid output. 

After a full grid resolution has been decided on, select a sub grid with the dialog shown in  
Figure 3-31: 
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Figure 3-30. Sub Grid Selection Dialog 

This allows you to concentrate on a specific area of interest.  For example, if you wanted to have a 
very detailed grid analysis with 40 grid points in both the X and the Y direction, concentrate on 
the lower left quadrant by setting the ‘X Range’ from 1 to 20 and the ‘Y Range’ from 1 to 20.  The 
result is a computation grid that is 20 by 20, calculating the noise in the lower left corner only.  
An additional advantage of this is that the end-results of the grids can be concatenated together 
to give a larger grid.  Figure 3-32 shows how the subgridding fits together in a larger grid. 

 

Figure 3-31.  Example of a 40 by 40 Main Grid with the Lower Left Quadrant Selected as a Subgrid 

For example, four computers can be set to do the calculations for the 40 by 40 grid described 
above, with each computer taking one corner.  In the end, the output of all four computers can be 
added together to produce the final result.  This way, instead of a large case taking 40 minutes to 
do all of the calculations, it only takes 10 minutes on 4 different computers.  Appendix D gives 
the details on concatenation of the files. 
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After selecting a sub-grid a standard windows file select dialog will appear.  The resulting output 
file will have a ‘*.tig’ extension and will contain the complete time history for every grid point in 
the analysis.  This file is viewable with the NMSim Visualizer (see Section 4). 

3.9.3.2 Receiver Sites Output 

Selecting the menu item ‘Output -> Receiver Sites’ (or press the F3 key) will start the receiver site 
output process.  A standard windows file select dialog will appear asking for a file name.  This 
file will have an ‘*.tis’ extension and will contain the complete time history for every receiver site 
in the analysis. 

3.9.3.3 Visualizer 

Selecting the menu item ‘Output -> Visualizer’ (or press CTRL-V) will start the process of 
outputting the data to the NMSim Visualizer.  The process is the same as the one for outputting a 
full grid analysis outlined in Section 3.9.3.1.  After a file name is selected the program will 
proceed with the full grid analysis, followed by the Receiver Site analysis, using the same root file 
name.  The result is a pair of files with the same root name but with the extension ‘*.tig’ for the 
grid analysis and the extension *.tis for the receiver site analysis.  After the computations are 
complete the program will automatically launch the NMSim Visualizer and upload the generated 
grid file.  See Section 4.0 for details about the NMSim Visualizer. 

3.9.4 Miscellaneous NMSim Items 

The following are a few items that do not easily fall within any of the previous sections. 

3.9.4.1 Case Info 

Each NMSim case has associated with it a set of user-enterable information.  Selecting the menu 
item ‘File -> Case Info’ brings up the dialog shown in Figure 3-33. 
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Figure 3-32. NMSim Case Information Dialog 

This dialog maintains information about when the case was originally created and when it was 
modified.  In addition it has a ‘Notes:’ field where any additional information can be entered.  To 
save the changes made to the ‘Notes:’ field, click ‘OK’.  Clicking ‘Cancel’ will not save the 
changes.  This information is stored in the NMSim control file (*.nms) and can be viewed by 
simply opening the control file in a text editor.  This allows you to examine notes about the case 
without having to launch NMSim.  You will be prompted to enter data here when you save your 
NMSim case. 

3.9.4.2 Background Layers 

The background layer files can be quickly removed from the map by selecting the menu item 
‘View -> Background Layers’.  This will toggle the check mark next to the menu item and either 
remove or redraw the layers, depending on their current state. 

3.9.4.3 Editing Cases 

To make any changes to the case files, select the menu item ‘Edit’.  This will bring up the NMSim 
File Loading/Editing dialog shown in Figure 3-1.  Make any desired changes to the case files here 
and click ‘OK’ to proceed. 

3.9.4.4 Saving Cases 

To save an NMSim case to another file name, select the menu item ‘File -> Save As’.  This will 
bring up the standard windows file select dialog.  The file extension will be ‘*.nms’.  This will 
save the current case to a new file and will reset the case information to show no notes and have 
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the same creation and modification dates.  It will also open the Case Information Dialog (see 
Figure 3-31) to allow you to enter any details about the case. 

3.9.4.5 Launching the NMSim Scheduler 

To run a more complicated case with multiple time-sequenced sources you need to use the 
NMSim Scheduler (see Section 4.1.4).  This can be launched by either double clicking on the 
NMSim Scheduler icon in the NMSim folder, or by selecting the menu item ‘File -> Launch 
Scheduler’.  This will launch the NMSim Scheduler and automatically fill in the working files 
from the current NMSim case.  Make any desired adjustments to these files before running this 
case. 
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4.0 NMSim Visual izer  

The NMSim Visualizer is a post processing application that allows you to examine the results 
from a NMSim full grid analysis.  The NMSim Visualizer shows the same base map as the 
original NMSim case with one major difference:  the NMSim Visualizer shows the noise levels 
over the area of noise calculations with color contours.  This gives you a quick and accurate 
understanding of how the noise propagates away from the noise source. 

The NMSim Visualizer can also analyze the results of the site output (*.tis) from NMSim.  This, 
however, requires that the site and grid output files have the same root name (differing only by 
the extension). 

The NMSim Visualizer will be automatically launched if the menu item ‘Output -> Visualizer’ is 
selected from the NMSim menu.  This also automatically loads the last grid analysis generated by 
NMSim.  An alternative is to launch the NMSim Visualizer directly by double clicking on the 
program icon in the NMSim program folder.  Then, to load a new case, select the menu item ‘File 
-> Open ‘ and load a *.tig file. 

4 . 1  R u n n i n g  t h e  V i s u a l i z e r  

After generating a full grid analysis (see Section 3.9.3), the results may be viewed with the 
NMSim Visualizer.  The following example uses the Fort Ticonderoga files supplied with the 
installation in the FortTiCase folder (see Section 2.1) with a 40 by 40 grid and subgrid used for the 
analysis.  After the grid file is loaded, either automatically from NMSim or by selecting the menu 
item ‘File -> Open -> xxx.tig’, the Visualizer Interactive screen shown in Figure 4-1 will appear. 
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Figure 4-1. NMSim Visualizer Interactive Screen 

4.1.1 Visualizer Interactive Screen 

This screen shows the study area map with color added to represent the noise.  The screen is 
initially all white (representing 25 dBA or below).  This is because, at the first point in the 
trajectory, no time has elapsed so the sound has not had a chance to propagate outward.  To see 
the noise it is necessary to move the source vehicle along the trajectory (see Section 4.1.2).  A 
display at the bottom of the window shows the coordinates, frame number and noise level at the 
current mouse cursor position in Lat/Long, UTM, and the user-defined system.  The frame 
number (on the far right hand side of this display) is a counter that shows which frame of the 
time history is currently viewed.  Each frame corresponds directly with a position along the 
source vehicle’s trajectory. 
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Just to the right of the main screen is the contour legend.  This explains what levels the various 
colors represent.  It is possible to change these default settings by selecting the menu item 
‘Options -> Contour Range’.  This will bring up the dialog shown in Figure 4-2: 

 

Figure 4-2. Noise Contour Selection Dialog 

This allows any desired range to be set.  Any metrics that are equal to the upper limit or above 
are drawn in red.  Any metrics that are lower than the lower limit are left in white.  These limits 
become especially important while viewing some of the comparative metrics.  For example, with 
the Time Above Ambient metric (see Section 4.1.2.2), the metric units are in minutes.  For a flight 
lasting only 15 minutes the Time Above metric will never be more than 15 minutes. 

4.1.1.1 Elevation Contours 

The contour interval dialog is to the lower right hand side of the window and is shown in Figure 
4-3.  This allows you to change to interval of the elevation contours drawn on the map.  In some 
instances it is helpful to increase or decrease these intervals.  For example, the Grand Canyon has 
a total elevation change of roughly 5000 feet.  If the contour intervals were drawn every 100 feet 
this would become too cluttered to be useful.  The minimum level is 10-foot intervals.  Also, the 
system will not draw more than 100 contour intervals regardless of the selected value. 

 

Figure 4-3. Contour Interval Dialog 

4.1.2 Visualizer Controls 

The Visualizer is run through a combination of keyboard menu inputs.  The following sections 
provide a description of the various ways to control the NMSim Visualizer. 
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4.1.2.1 Keyboard Controls 

The source vehicle can be moved along the track by pressing the up arrow key to move forward 
and the down arrow key to move backwards.  Pressing the control key (CTRL) in conjunction 
with the up or down arrow key will move the vehicle 10 time steps either forward or backwards.  
In addition, pressing the ‘Home’ key will bring the vehicle to the first trajectory position while 
pressing the ‘End’ key will move the vehicle to the end of the trajectory.  The Table 4-1 lists 
additional keyboard inputs: 

Table 4-1. Visualizer Key Commands 

 
Up Arrow ............................................................Move forward 1 time increment. 

CTRL-Up Arrow.................................................Move forward 10 time increments 

Down Arrow......................................................Move back 1 time increment. 

CTRL-Down Arrow ..........................................Move back 10 time increments. 

Home ...................................................................Jump to the first time increment. 

End........................................................................Jump to the last time increment. 

A.............................................................................Show A-Weighted time history 

F .............................................................................Show Flat-Weighted time history 

C.............................................................................Show C-Weighted time history 

M............................................................................Show Lmax with current weighting  
                                                              (A-weight is default) 
 

4.1.2.2 Visualizer Metrics 

In addition to showing the instantaneous noise levels, the NMSim Visualizer has many different 
metrics.  Some of the metrics are available through the keyboard, but all are available from the 
menu item ‘View’.  The following is a list of the available metrics and a brief description. 

 Flat Weight: Show Flat-Weighted time history for the current location of the source 
along the trajectory. 

 A Weight: Show A-Weighted time history for the current location of the source along 
the trajectory.  

 C Weight: Show C-Weighted time history for the current location of the source along 
the trajectory. 

 Flat Weighted Lmax: Show Flat-Weighted max level for the complete trajectory. 
 A Weighted Lmax: Show A-Weighted max level for the complete trajectory. 
 C Weighted Lmax: Show C-Weighted max level for the complete trajectory. 
 Leq: Shows the equivalent noise level for a 24-hour period for the complete trajectory. 
 Ldn: Shows the Day/Night level for a 24 hour period for the entire set of flights 

shown.  This is useful when a large number of flights have been setup using the 
NMSim Scheduler. 
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 Time Above Ambient:  The time in minutes that the A-weighted sound level is above 
the local ambient level for the complete trajectory.  This option requires that an 
ambient noise file was selected when generating this case in NMSim. 

 Time Audible:  The time in minutes that the noise is audible to the average human for 
the complete trajectory.   This option requires that an ambient noise file was selected 
when generating this case in NMSim or else the results will use the threshold of 
human hearing as the ambient. 

 % Time Audible:  The percent of the time that the vehicle is audible (based on the total 
travel time of the source).  This option requires that an ambient noise file was selected 
when generating this case in NMSim or else the results will use the threshold of 
human hearing as the ambient. 

4.1.2.3 Drawing Options 

You may chose to remove some or all of the features from the map.  Do to this, select the menu 
item ‘Options -> Drawing Options’.  This will bring up the dialog shown in Figure 4-4: 

 

Figure 4-4. Visualizer Drawing Options Dialog 

The receiver sites are, by default, not drawn.  To add them in, simply check the ‘Receiver Sites’ 
box.  Once the desired drawing options have been selected, clicking ‘OK’ will redraw the screen 
with only the selected options drawn. 

4.1.3 Visualizer Capture Options 

The NMSim Visualizer allows the data to be stored in several ways; from the menu item 
‘Capture’ select either ‘Video’, ‘Still’, or ‘Data’.  The following sections describe these options. 

4.1.3.1 Video 

To create a video file (*.avi format) of the current NMSim case, select the menu item ‘Capture -> 
Video’.  First, the dialog shown in Figure 4-5 will appear: 
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Figure 4-5. Video Frame Selection Dialog 

By default this dialog is set to span the entire case.  In some instances you may want to focus in 
on a particular section of the trajectory.  If this is the case, select the specific frames.  First 
navigate through the trajectory to determine which frames are of interest.  These frames should 
then be entered into the Frame Selection dialog shown in Figure 4-5.  After the frame range has 
been accepted a standard windows file selection dialog will appear asking for a video file name. 

After a name has been chosen the Visualizer will proceed by making a still image of every frame 
in the selected range.  A progress bar tells how far along in the process it is.  The images are given 
the name ‘VidCap###.png’, where the ‘###’ represents the number of the image (always starting 
from 1).  These files are stored in a folder with the same name you selected for the file name.  This 
folder is created if it does not already exist. 

After all of the images are created the program generates the video (see Appendix E for more 
details).  After the video is finished you no longer need to save the intermediate files and can 
delete them.  They are stored in a ‘Vidcap’ subdirectory within the video’s directory.  If the files 
are saved, however, it is possible to rebuild the video with different options (see Appendix E), or 
use them as still images. 

After the video has been created you are given the option to look at the newly generated video.  
Also, after the video has been generated, view it at any time by selecting the menu item ‘View -> 
Last Video’.  This will bring up the last video generated and play it again. 
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4.1.3.2 Still 

Capture the current view into an image file by selecting the menu item ‘Capture -> Still’.  Select 
several different image formats by using the windows file type selection at the bottom of the 
windows file select dialog.  The supported image formats are as follows: 

 Bitmap (*.bmp)  
 PC Paintbrush (*.pcx) 
 Portable Network Graphics (*.png)   
 Run Length Encoded (*.rle) 

4.1.3.3 Data 

You can save the currently displayed data in a number of ways by selecting the menu item 
‘Capture -> Data’.  The data can be saved in the ESRI ASCII grid format, or in the NMPlot 
NMGBF format.  Also, if there is a site file (*.tis) with the same root name as the grid file, you can 
save composite information about the sites in a text file.  The following sections describe these 
options. 

4.1.3.3.1 ESRI ASCII Grid Output 

Data stored in the ESRI ASCII grid format must be stored with square grid cells.  Visualizer 
allows you to select this cell size through the dialog shown in Figure 4-6: 

 

Figure 4-6. ESRI ASCII Grid Cell Size Dialog 

The Visualizer will save the currently displayed noise levels onto an ESRI ASCII grid with this 
cell size.  If the measurement area is not an integer multiple of the grid size some data will be lost. 

The lower left hand corner of the study area is stored in the ESRI ASCII grid in UTM 84, with the 
grid cell size stored in meters.  The No-Data value is set to –99.9 and the data is stored with 
whatever units are used for the currently displayed metric. 
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4.1.3.3.2 MGBF (NMPlot) Output 

NMPlot is an application for viewing geo-referenced data available for download from Wasmer 
Consulting (http://wasmerconsulting.com/nmplot.htm).  It is a general-purpose application that 
generates noise contours from gridded noise data.  To quote from the web site, “NMPlot can 
produce contour and color gradient plots, apply mathematical transformations to grids, combine 
two grids, and interface with GIS systems”. 

NMSim will output data in a format that can be read by NMPlot.  For further details about the 
file format, visit the NMPlot website.  The latest version of NMPlot was shipped with NMSim so 
that, when you output to the NMGBF format, NMSim will automatically launch NMPlot and 
load up the current contours. 

4.1.3.3.3 Metrics at Sites Output 

If the NMSim case has a receiver site file (*.tis) with the same root name as the grid file, the 
Visualizer can output a text file that lists all of the key metrics for each site.  (Note that if the 
output for Visualizer was selected from within NMSim, both the grid and the site files were 
automatically generated.)  These metrics are: 

 Flat-Weighted Max 
 A-Weighted Max  
 Leq 
 Ldn 
 Time Above Ambient 
 Time Audible 

See Section 4.1.2.2 for details about these metrics and see Appendix D for an example file.  If for 
some reason the receiver site file is not present an error message will appear.  If the receiver site 
file is present, but it has a different set of sites than what is expected, an error message will 
appear in the file. 

4.1.4 Miscellaneous Visualizer Items 

The following are a few items that do not easily fall within any of the previous sections. 

4.1.4.1 Case Info 

Selecting the menu item ‘File -> Case Info’ will bring up the dialog shown in Figure 4-7.  
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This dialog shows the date and time that the current grid file was created, along with the header 
information.  The header information shows the files and grid size originally used by NMSim to 
generate this grid file.   This dialog is for informational purposes only and is not editable. 

 

Figure 4-7. Visualizer Case Information Dialog 

4.1.4.2 Saving Cases 

To save the currently shown case into a different file name, select the menu item ‘File -> Save As’.  
This will bring up the standard Windows file select dialog. 

4.1.4.3 Multiple Trajectories 

If this grid data file was generated using the NMSim Scheduler (see Section 5) it is possible that 
the case has multiple trajectories associated with it.  If this is the case, the Visualizer will show all 
of the different sources moving at the appropriate time.  Each source will have a distinct 
Trajectory File that the Scheduler will create.  The Visualizer will only show those sources on the 
screen that actively generate sound.  For more details about multiple sources, see Section 5.1.3. 
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5.0 NMSim Scheduler  

The NMSim Scheduler allows you to run complex, multiple source cases.  Any number of 
different flight tracks and sources can be combined and scheduled to run at different times in a 
day.  The program then runs the necessary NMSim cases and combines the results into single set 
of time history files.  This final set of files can then be viewed and post-processed with the 
Visualizer. 

The Scheduler is designed to examine the impact of multiple sources acting simultaneously.  It 
first generates all of the time histories for each distinct operation.  It then takes these time 
histories and adds them together, inserting the correct time offset.  It is not intended as a way to 
schedule a long list of single events.  One method of running long lists of single events is to use 
the NMSim Batch program along with a script file.  This eliminates the need to go through the 
user interface for every change.  Detail of this process can be found in Appendix F. 

You should use a certain amount of caution when running very large cases through the scheduler 
because it is possible to run into memory storage problems.  For example, if you have a case that 
is run over a grid that is 80X80, with a Trajectory File that has 1500 time steps in it, this requires 
roughly 1.5 GB of memory.  To relieve the computer of this memory requirement the program 
uses the computer’s hard drive to temporarily store this data as it works through the case.  For 
this reason you need to ensure that you have sufficient disk space before starting a large study. 

5 . 1  R u n n i n g  t h e  S c h e d u l e r  

The NMSim Scheduler can either be launched directly by double clicking on its icon, or by 
selecting the NMSim menu item ‘File -> Launch Scheduler’ (see Section  3.9.4.5).  If the latter 
method is used, NMSim will export the current case directly into the Scheduler.  A blank window 
will appear with a dialog in the center.  If the program is launched with the program icon, all 
fields in this dialog are blank.  If the Scheduler is launched from NMSim, this dialog is filled with 
the last NMSim case files.  This dialog has two tabs; a NMSim Data Tab and a Track List tab.  
These are shown discussed in the following two sections.  The data for these two tabs can be 
entered in any order. 

A case that was previously generated may be loaded by selecting the menu item ‘File -> Load 
Case’.  This will bring up a standard windows file select dialog.  You will be prompted to select a 
scheduler build file with the extension ‘*.sch.’  Selecting this file will bring up all of the case files, 
trajectories and operations for that case.  
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5.1.1 NMSim Data Tab 

 

Figure 5-1. NMSim Scheduler Case Information Dialog – NMSim Data Tab 

The NMSim Data tab, shown in Figure 5-1, is used to select the required and optional NMSim 
files.  The Fort Ticonderoga case files were used for this example.  To change a file, press the 
associated ‘Browse’ button.  You may select an Elevation file, a Receiver Site file, an Impedance 
file, an Ambient Noise file, and a Background Layer file in this manner.  Of all of these files, only 
the Elevation file is necessary.  These files are the same used for a single event NMSim case and 
are used for all parts of this multiple event case. 
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5.1.2 Track List Tab 

 

Figure 5-2. NMSim Scheduler Case Information Dialog – Track List Tab 

The Track List tab is where you can add and schedule a whole set of different noise events, 
ranging from a simple one flight case to a much more complicated situation dealing with 
multiple flights and ground vehicles. 

Each operation is composed of two parts.  There are the trajectories, and there are the operations.  
The trajectory defines the source’s motion and the operation defines which vehicle followed that 
trajectory at what time. 

For example, the Fort Ticonderoga case uses a single Trajectory File (FortTiFlight.trj).  This 
describes the flight of an aircraft up Lake George.  A schedule with a Cessna 182 set to follow that 
track at 10:00 am, and then a Cessna 207 to follow that same track at 10:15 am, constitutes two 
operations for that specific flight track. 

The dialog shown in Figure 5-2 shows the trajectories file with the total number of operations 
associated with it.  You may add or remove trajectories or edit the operations associated with a 
trajectory.   
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5.1.2.1 Add, Edit, or Remove a Trajectory 

To remove a trajectory, first select it by highlighting it with the mouse, then click the ‘Remove’ 
button.  To edit an existing trajectory, highlight it with the mouse, then click the ‘Edit’ button.   
This will bring up the dialog shown in Figure 5-3: 

 

Figure 5-3. Trajectory Details Dialog 

To add a new trajectory, press the ‘Add Track’ button.  This will bring up the same dialog as 
shown in Figure 5-3, but with all the fields blank. 

The Trajectory and Operations dialog shows the selected Trajectory File in the field along the top.  
Change this by pressing the ‘Browse’ button next to it.  This will bring up the standard windows 
file select dialog allowing you to choose a new file. 

Below the Trajectory File are listed the current operations associated with that trajectory.  In the 
example shown in Figure 5-3 there is a single Omni Directional source set to start on the 
trajectory at midnight, January 1, 2000.  You may add or remove operations, or edit the 
operations associated with this trajectory.  Once satisfied with the trajectory and all of its 
operations, click ‘OK’ to update the dialog shown in Figure 5-2. 
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5.1.2.2 Add, Edit, Remove or an Operation 

To remove an operation, first select it by highlighting it with the mouse, then click the ‘Remove 
Operation’ button.  To edit an existing operation, highlight it with the mouse, then click the ‘Edit 
Operation’ button.   This will bring up the dialog shown in Figure 5-4: 

 

Figure 5-4. Operation Details Dialog 

To add a new trajectory, press the ‘Add Operation’ button.  This will bring up the same dialog as 
shown in Figure 5-4, but with all the fields blank. 

This dialog shows the selected source, along with the desired time for that source to start along 
the trajectory.  Change the source by selecting the ‘Browse’ button.  The default values for the 
start time are midnight on January 1, 2003.  You may change these values to anything 
appropriate.  Note that for Ldn contours it is crucial that you select the correct time of day.  The 
Ldn metrics rely in the actual time of day of the event for their calculations.  For all other metrics, 
however, the time and date are used for relative times of the events so that the absolute time the 
events occur are not of great importance. 

After making the desired changes to the operation, click ‘OK’ to add it to the list in the dialog 
shown in Figure 5-3. 
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5.1.3 Running a Finished Case 

Once satisfied with the set of case files, trajectories, and operations associated with their case, 
press the ‘Run Case’ button in the dialogs shown in Figure 5-1 and Figure 5-2.  This will bring up 
the Output Parameters dialog shown in Figure 5-5: 

 

Figure 5-5. Scheduler Output Parameters Dialog 

This dialog allows you to specify how the scheduler will generate the output grids and/or site 
data.  To output the time histories at the sites, make sure that the check box ‘Receiver Sites’ is 
checked.  If it is not checked, no time histories for the receiver sites are generated.  Similarly, to 
generate a full grid output, the ‘Grid Output’ check box must be selected.  Both of these check 
boxes are selected by default. 

For the full grid data to be calculated you also need to select the grid resolution and the sub-grid 
used for the calculations.  See Section 3.9.3.1 for further details about the full grid output. 

The next item in this dialog is the case name.  Select a case name for the outputs from the 
Scheduler.  The program will create a folder with that name and put the grid data file (*.tig) and 
the site data file (*.tis) in that folder (provided that they were selected to be calculated).  The root 
name for the grid and site data files is also the case name. 
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The program will also put a series of Trajectory files simply called ‘Track001.trj’, ‘Track002.trj’, 
etc.  These Trajectory files are the time-corrected versions of the initial Trajectory files selected for 
this case.  For example, if there were two operations selected for the ‘FortTi.Trj’ flight trajectory, 
five minutes apart, then there would be two Trajectory files in the output folder named 
‘Track001.trj’, ‘Track002.trj’.  These two files would be identical accept that one would have a five 
minute time difference.  See Section 3-43 for more details about multiple Trajectory files. 

The final item to select on the Scheduler Output Parameter dialog is the output time step.  Select 
any time step you wish for the final output.  The Scheduler will interpolate all of the data into 
that time step and create the necessary Trajectory files.  The output will then be set to that time 
step. 

After setting all of the output parameters, press the ‘OK’ button to start the Scheduler 
calculations. 

5.1.3.1 Redundant Operations 

The NMSim Scheduler needs distinct time history files every time it generates the composite time 
history.  It does not, however, need to recreate operations that already exist.  The Scheduler puts 
all of the intermediate time history files into a folder called ‘pastcasefolder’.  Before each new run, 
the Scheduler checks to see if any of the selected operations have already been calculated.  If one 
of the operations does exist in the ‘pastcasefolder’, the Scheduler will give the option to 
recalculate that operation or not.  The more cases that are built using the Scheduler, the bigger the 
library of time history files will become.  This can be a great time saver.  Once a large set of time 
history files have been created, the Scheduler will only need to work the interpolations and will 
not need to generate the individual time histories. 

After the case is finished calculating, the Scheduler will offer the opportunity to view the results 
with the NMSim Visualizer.  This will load the completed combination of all the scheduled 
operations into the Visualizer where videos and stills can be generated, or the data can be 
exported in various ways (see Section 4). 
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APPENDIX A 
Ambient Noise File Format 

 

This appendix is provided for those who want to create their own ambient noise files.  Before you 
start, however, you will need to know the 1/3rd octave band spectra of the ambient noise.  All 
ambient noise in NMSim is stored in 1/3rd octave bands from 50 Hz to 10,000Hz, along with its 
A-weighted value.  Ambient noise data for NMSim may be contained in one or two files.  If there 
is a single ambient throughout the study area there will only be one file: the NMSim Ambient 
Noise file.  If there are multiple ambients there will be a second file: an ESRI ASCII grid file 
defining the ambient zones. 

The NMSim ambient noise file is a text file that lists the 1/3rd octave band levels of the local noise.  
The first line of the file gives the name of the ESRI ASCII grid file associated with this ambient 
file.  If there is no grid file the text in this line does not matter.  The default text for cases without 
a grid file is ‘No Grid’.  The second line gives the number of ambient spectra to follow.  If there is 
no grid file, this will always be 1.  If there is a grid file then this will be greater than 1.  The third 
and all following lines list the actual noise spectra and index details as follows: 

Commas separate all elements.  The first item is the index number.  The second item is a brief 
descriptive name of the spectrum.  The third item is the A-Weighted level for this spectrum, and 
the next 24 items list the levels of the spectrum from 50 Hz to 10,000 Hz. 

The following is an example of an Ambient file without a grid file associated with it: 

No Grid 

  1 

  1,Coniferous_Forest, 30.9, 35.4, 34.7, 33.9, 31.2, 29.2, 26.9, 25.0, 27.8,…  

For cases where there is a grid file you need to prepare an ESRI ASCII grid file.  This will require 
some third party GIS software capable of exporting to an ESRI ASCII grid file format.  The grid 
file should cover roughly the same area as the NMSim study area, and should be geo-referenced 
using geographic coordinates (latitude and longitude) using the WGS 84 projection.  The grid 
spacing of the ASCII grid file does not need to match the grid spacing for your NMSim case, and 
the study areas do not need to match perfectly.  NMSim will select the ambient grid point that is 
closest to the NMSim grid point and use that ambient spectrum. 

When creating the ambient grid file the goal should be to provide enough detail to isolate distinct 
acoustic zones.  For example, if there is a noisy river running through a study area that is fairly 
quiet, it is important to keep the grid point spacing small enough to resolve the river.  If you use a 
half-mile grid point spacing for the ambient grid, NMSim will pick the closest ambient grid point 
to the calculation grid point, and this could be as much as a quarter mile away from the ambient 
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grid point.  With calculations on either side of the river this could make the river look a half-mile 
wide.  Therefore it is important to understand the size of the ambient zones so that the grid 
spacing is appropriate.  The area in consideration should be large enough to encompass all of the 
ambient zones inside of the NMSim study area. 

The data listed in the ESRI ASCII grid file should be the index numbers associated with the 
spectra listed in the ambient noise file.  For example, if half of the study area uses the first spectra 
listed in the ambient noise file and the other half uses the second spectra listed, the ESRI ASCII 
grid file should be full of 1s and 2s.  It does not matter how many spectra are listed in the ambient 
noise file, but the ESRI ASCII grid file should only contain index numbers that are part of that 
list. 

For more details, see section 3.8 in the manual. 
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 APPENDIX B: 

Flight Trajectory Information 
 

In order to get the most accurate simulation of noise from an aircraft it is important to get the 
flight dynamics of the aircraft correct.  This includes the power setting, speed, and climb/decent 
rate that is appropriate for that aircraft.  The publicly released version of NMSim does not ship 
with a flight module to calculate these parameters for you.  Instead, we have included a brief list 
of aircraft flight profiles as extracted from the INM data base.  This provides a first 
approximation of the appropriate flight profiles to use in NMSim. 

The heading on each of the tables below provides the needed information for entry into NMSim.  
The ‘Distance’ heading represents the distance in feet to the end of the runway.  Note that for 
arrivals that distance is negative and for departures it is positive.  The heading ‘Altitude’ is in feet 
above ground level (AGL) from the runway altitude.  The heading ‘Speed’ is in knots, ‘THR_SET’ 
is the actual throttle setting listed in the INM data base, and the heading ‘THR_PER’ represent 
the throttle percentage.  It is this percentage that is appropriate to use for the NMSim flight 
tracks. 

It is important to remember that these flight parameters are first estimates on aircraft 
performance.  The user should understand the impact of the changes they make and how realistic 
they are for the aircraft they are using. 
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Airbus 320 
 

A320 Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-146131.2 6000.0 272.3 566.67 3% 

-105288.0 4017.0 264.7 463.62 2% 

-84710.6 3000.0 260.9 415.13 2% 

-63677.2 3000.0 209.9 570.65 3% 

-58969.2 3000.0 196.0 612.04 3% 

-57240.1 3000.0 190.2 644.65 3% 

-54179.1 2840.0 188.6 649.58 3% 

-49868.1 2614.0 180.4 688.71 3% 

-37066.3 1943.0 145.0 844.47 4% 

-35927.8 1883.0 140.6 858.26 4% 

-33923.2 1778.0 131.0 884.95 4% 

-33509.8 1756.0 130.9 4532.60 22% 

-19080.7 1000.0 129.5 4408.13 21% 

-954.1 50.0 127.7 4237.43 20% 

0.0 0.0 127.0 800.00 4% 

2340.0 0.0 30.0 800.00 4% 

 

A320 Stage Length 3 Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 23555.00 112% 

4266.6 0.0 153.6 20074.79 96% 

9254.0 1000.0 155.8 20425.10 97% 

14411.4 1306.6 200.1 19558.14 93% 

17063.1 1459.6 219.7 19183.82 91% 

18063.1 1601.1 220.1 16092.62 77% 

22297.9 2200.0 222.1 16244.56 77% 

28104.0 3000.0 224.8 16411.20 78% 

36180.4 3369.5 262.8 16348.99 78% 

52859.0 5500.0 271.4 16808.45 80% 

69716.7 7500.0 279.8 17256.25 82% 

92631.5 10000.0 290.9 17838.50 85% 
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Boeing 777-300 
 

777-300 Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-61102.0 3000.0 192.0 2231.0 11% 

-56765.0 3000.0 179.0 5883.5 28% 

-54191.0 3000.0 169.0 6413.0 31% 

-54191.0 3000.0 169.0 2151.0 10% 

-52237.0 2892.0 165.0 2077.5 10% 

-48787.0 2702.0 150.0 2203.5 10% 

-48454.0 2683.0 148.0 2224.5 11% 

-48454.0 2683.0 148.0 20314.0 97% 

-47301.0 2620.0 148.0 20266.0 97% 

-42598.0 2359.0 147.0 20073.0 96% 

-37914.0 2099.0 147.0 19883.5 95% 

-33249.0 1841.0 146.0 19696.0 94% 

-28603.0 1583.0 146.0 19512.0 93% 

-23974.0 1326.0 145.0 19330.0 92% 

-19364.0 1071.0 145.0 19151.0 91% 

-14772.0 816.0 144.0 18974.5 90% 

-10198.0 562.0 143.0 18800.0 90% 

-5642.0 309.0 143.0 18629.0 89% 

-1103.0 57.0 142.0 18460.0 88% 

-979.0 50.0 142.0 18460.0 88% 

0.0 0.0 140.0 18455.0 88% 

850.0 0.0 109.0 4818.00 23% 

1851.0 0.0 7.0 1037.00 5% 
 

777-300 Stage Length 4 Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 87833.80 110% 

4584.0 0.0 165.9 71607.36 90% 

9527.5 1058.0 168.5 71898.77 90% 

10527.5 1124.5 172.8 53813.82 67% 

24056.7 2024.7 231.1 50530.03 63% 

31420.8 3000.0 234.5 51388.57 64% 

39861.8 3535.5 263.4 50039.30 63% 

52069.1 5000.0 269.3 51328.31 64% 

74151.8 7500.0 279.8 53528.50 67% 

98050.7 10000.0 290.9 55728.68 70% 

 



Noise Model Simulation (NMSim) 
User’s Manual 

 
 
  

 
 

B-5 
 
 

 June 2005 
 WR-03-09 

Boeing 757 RR 
 

757 RR Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-114486.8 6000.0 273.4 365.61 1% 

-57243.4 3000.0 167.3 1907.61 5% 

-28621.7 1500.0 139.7 6302.90 18% 

-19081.1 1000.0 136.7 7658.07 21% 

0.0 0.0 134.7 7385.36 21% 

322.2 0.0 127.8 24060.00 67% 

3222.0 0.0 30.0 4010.00 11% 
 

757 RR Stage Length 3 Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 37092.00 103% 

3090.7 0.0 146.5 32182.88 89% 

6514.9 1000.0 148.7 32582.68 91% 

7078.4 1084.4 154.4 32433.62 90% 

9151.1 1369.6 175.5 31877.55 89% 

10151.1 1423.1 184.3 24844.80 69% 

13414.1 1597.8 212.9 23877.75 66% 

16056.4 1720.7 233.8 23338.63 65% 

23160.3 3000.0 238.3 23869.90 66% 

26688.9 3146.6 261.9 23281.83 65% 

40959.1 5500.0 271.4 24259.15 67% 

53840.6 7500.0 279.8 25089.75 70% 

71057.4 10000.0 290.9 26128.00 73% 
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Boeing 747-200 
 

747-200 Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-114486.8 6000.0 273.4 968.86 2% 

-57243.4 3000.0 167.3 5712.12 14% 

-28621.7 1500.0 158.5 7860.18 20% 

-19081.1 1000.0 146.1 12073.33 30% 

0.0 0.0 144.0 11643.38 29% 

462.6 0.0 136.6 27300.00 68% 

4626.0 0.0 30.0 4550.00 11% 
 

747-200 Stage Length 4  Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 42780.70 107% 

6351.7 0.0 165.3 34417.62 86% 

13808.8 1000.0 167.8 34756.20 87% 

26768.0 2101.3 201.1 33602.23 84% 

27768.0 2136.4 204.4 28898.07 72% 

39749.3 2556.0 244.0 27274.73 68% 

44177.7 3000.0 245.7 27385.56 68% 

50665.9 3197.2 267.4 26563.43 66% 

76612.6 5500.0 276.8 27070.91 68% 

101701.8 7500.0 285.4 27432.51 69% 

137276.5 10000.0 296.7 27781.01 69% 
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Boeing 737-300 
 

737-300 Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-114486.8 6000.0 273.4 716.22 3% 

-57243.4 3000.0 177.7 1619.20 8% 

-28621.7 1500.0 151.9 3222.65 15% 

-19081.1 1000.0 141.1 3930.44 19% 

0.0 0.0 139.0 3790.47 18% 

3168.0 0.0 30.0 2000.00 9% 
 

737-300 Stage Length 3  Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 18745.00 89% 

4489.1 0.0 156.8 15589.70 74% 

9140.7 1000.0 159.1 15994.00 76% 

12112.4 1312.9 180.4 15714.52 74% 

14124.6 1504.9 194.3 15530.68 73% 

15124.6 1555.7 202.3 14391.52 68% 

16716.3 1636.5 215.1 14065.62 66% 

24609.1 3000.0 219.5 14277.90 67% 

31448.6 3295.0 262.5 13631.02 64% 

46209.8 5500.0 271.4 13974.35 66% 

60715.4 7500.0 279.8 14285.75 67% 

80565.2 10000.0 290.9 14675.00 69% 
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Boeing 727EM2 
 

727EM2 Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-114486.8 6000.0 273.4 543.35 4% 

-57243.4 3000.0 167.3 2041.50 15% 

-28621.7 1500.0 152.9 3144.00 22% 

-19081.1 1000.0 149.8 4883.35 35% 

0.0 0.0 143.5 4709.44 34% 

347.6 0.0 140.0 9300.00 66% 

3476.0 0.0 30.0 1550.00 11% 

 
727EM2 Stage Length 3 Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 14713.60 105% 

7019.6 0.0 171.1 13437.39 96% 

13901.3 1000.0 173.6 13800.37 99% 

14713.3 1056.6 177.7 13791.87 99% 

21237.7 1468.8 209.5 13684.26 98% 

22237.7 1517.2 213.4 10953.05 78% 

23918.2 1598.6 220.1 10892.92 78% 

36769.9 3000.0 224.8 11118.38 79% 

48428.1 3496.6 263.3 10914.53 78% 

69093.2 5500.0 271.4 11237.01 80% 

91339.2 7500.0 279.8 11558.81 83% 

121801.0 10000.0 290.9 11961.05 85% 
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CNA 441 
 

CNA 441 Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_SET 

-114486.8 6000.0 175.0 15.65 16% 

-57243.4 3000.0 119.1 21.25 21% 

-28621.7 1500.0 106.2 26.30 26% 

-19081.1 1000.0 95.3 31.90 32% 

0.0 0.0 93.9 30.77 31% 

79.1 0.0 89.1 40.00 40% 

791.0 0.0 30.0 10.00 10% 
 

CNA 441 Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 110.38 110% 

2082.1 0.0 110.0 110.38 110% 

3022.0 103.2 120.2 101.41 101% 

5195.5 313.9 140.6 87.32 87% 

20865.1 3000.0 146.3 92.57 93% 

21865.1 3154.4 146.7 90.31 90% 

37057.5 5500.0 152.0 95.46 95% 

50784.0 7500.0 156.7 99.85 100% 

69005.1 10000.0 162.9 105.73 106% 
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DHC6QP 
 

DHC6QP Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-114486.8 6000.0 131.3 8.35 8% 

-57243.4 3000.0 84.4 12.17 12% 

-28621.7 1500.0 72.3 21.97 22% 

-19081.1 1000.0 61.6 36.20 36% 

0.0 0.0 60.7 34.91 35% 

39.6 0.0 57.6 40.00 40% 

396.0 0.0 30.0 10.00 10% 
 

DHC6QP Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 97.82 98% 

1239.2 0.0 88.0 97.82 98% 

5957.5 1000.0 89.3 99.95 100% 

6891.9 1097.9 99.6 89.94 90% 

7891.9 1287.0 99.9 85.42 85% 

16948.3 3000.0 102.4 89.04 89% 

30819.0 5500.0 106.4 94.11 94% 

42492.2 7500.0 109.7 98.45 98% 

57864.7 10000.0 114.0 104.24 104% 
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DC6 
 

DC6 Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-114486.8 6000.0 175.0 17.35 17% 

-57243.4 3000.0 110.9 17.82 18% 

-28621.7 1500.0 98.2 27.64 28% 

-19081.1 1000.0 87.4 39.86 40% 

0.0 0.0 86.1 38.44 38% 

175.5 0.0 81.7 40.00 40% 

1755.0 0.0 30.0 10.00 10% 
 

 
 
 
 
 
 
 
 
 
 
 

DC6 Stage Length 2 Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 100.58 101% 

4201.4 0.0 132.5 100.58 101% 

20091.4 1500.0 135.5 103.90 104% 

23400.9 1656.9 146.5 96.63 97% 

24400.9 1725.7 146.7 89.00 89% 

42905.6 3000.0 149.5 91.65 92% 

81573.8 5500.0 155.2 96.87 97% 

115013.5 7500.0 160.1 101.33 101% 

160420.8 10000.0 166.4 107.29 107% 
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General Aviation Variable Pitch 
 

GA Variable Pitch Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-68580.3 6000.0 109.4 11.76 12% 

-34290.2 3000.0 79.4 15.65 16% 

-17145.1 1500.0 67.5 35.21 35% 

-11430.1 1000.0 67.0 34.57 35% 

0.0 0.0 66.0 33.34 33% 

42.8 0.0 62.6 31.00 31% 

428.0 0.0 30.0 10.00 10% 
 

GA Variable Pitch Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 163.92 164% 

631.7 0.0 55.6 163.92 164% 

1014.5 42.7 66.0 138.25 138% 

2505.6 172.0 90.2 101.67 102% 

8353.8 1000.0 91.3 103.50 104% 

9817.7 1102.8 101.6 93.36 93% 

10817.7 1209.1 101.8 86.89 87% 

27675.8 3000.0 104.5 90.57 91% 

52917.7 5500.0 108.5 95.72 96% 

74698.5 7500.0 111.9 100.13 100% 

104196.7 10000.0 116.4 106.03 106% 
 



Noise Model Simulation (NMSim) 
User’s Manual 

 
 
  

 
 

B-13 
 
 

 June 2005 
 WR-03-09 

General Aviation Fixed Pitch 
 

GA Fixed Pitch Arrival 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

-68580.3 6000.0 109.4 21.20 21% 

-34290.2 3000.0 71.8 26.71 27% 

-17145.1 1500.0 60.0 30.71 31% 

-11430.1 1000.0 59.6 30.15 30% 

0.0 0.0 58.7 29.08 29% 

47.2 0.0 55.7 27.20 27% 

472.0 0.0 30.0 10.00 10% 
 

GA Fixed Pitch Departure 

DISTANCE ALTITUDE SPEED THR_SET THR_PER 

0.0 0.0 35.0 113.06 113% 

738.3 0.0 62.1 113.06 113% 

1712.7 51.4 73.1 96.32 96% 

12024.6 1000.0 74.1 98.31 98% 

14194.9 1097.7 84.3 86.65 87% 

15194.9 1161.5 84.4 81.16 81% 

43986.9 3000.0 86.8 84.60 85% 

87528.9 5500.0 90.1 89.42 89% 

126776.4 7500.0 92.9 93.53 94% 

182799.4 10000.0 96.6 99.04 99% 
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APPENDIX C: 
Noise Sources 

C .1  Ground Sources  

The highway vehicles were modeled using data taken from the Traffic Noise Model6, while the 
train was modeled using data from Wyle Laboratories Railroad Noise Handbook7.  All sources 
are assumed to be simple (omni directional sources).  This is an over simplification of the actual 
sources.  For critical situations, these should be replaced with sources based on proper 
measurements, similar to those performed for the Military Sources or the Air Tour sources.  The 
following are the available ground noise sources for NMSim, along with a brief description. 

 

 
 Train.src............................................Noise Source for a Train Locomotive 

 Motorcycle.src ................................Noise source for an average motorcycle 

 MediumTruckCC.src .....................A medium sized truck driving on concrete 

 MediumTruckAvg.src...................A medium sized truck driving on average pavement 

 HeavyTruckCC.src.........................A heavy sized truck driving on concrete 

 HeavyTruckAvg.src ......................A heavy sized truck driving on average pavement 

 CarCC.src ..........................................A car driving on concrete 

 CarAvg.src........................................A car driving on average pavement 

 BusCC.src..........................................A bus driving on concrete 

 BusAvg.src .......................................A bus driving on average pavement 
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C.2 Mil i tary Aircraft  Sources  

These are sources that Wyle Laboratories developed from original time histories and tracking 
data collected by the U.S. Air Force.  This is the ideal source development procedure.  The 
directivity patterns and spectra for these aircraft will be much more accurate than any of the 
other sources. 

 

 

 tornado.src ......................................Noise source for a British Tornado Fighter 

 F16.src...............................................Noise source for an F-16 

 

 

 Air Tour Helicopter Sources 

 

 B206L.src ......................................... Bell 206L helicopter noise source 

 B206B.src......................................... Bell 206B helicopter noise source 

 AS350.src ......................................... Bell 206B helicopter noise source 

 

  

 Air Tour Fixed Wing Sources 

 

 DCH6.src...........................................Dash 6 noise source (Air Tour Version) 

 C207.src............................................ Cessna 207 noise source 

 C182.src............................................ Cessna 182 noise source 
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C.3 INM Converted Sources  

These are sources that have been converted from the INM database to standard NMSim sources.  
Directivities were based on INMs Behind Start-of-Takeoff-Roll algorithm, and spectra were based 
on spectral classes.  For critical situations, these should be replaced with sources based on proper 
measurements, similar to those performed for the Military Sources or the Air Tour sources. 

 
  

 b727.src............................................ Boeing 727 noise source 

 b737.src............................................ Boeing 737-300 noise source 

 b757.src............................................ Boeing 757-200 noise source 

 b777.src............................................ Boeing 777-200 noise source 

 bbaron.src........................................ Beachcraft Baron 58P noise source 

 CNA441.src ..................................... Cessna 441 aircraft noise source 

 DC6.src..............................................McDonald Douglas DC6 noise source 

 DHC6.src...........................................Dash 6 noise source (INM Version) 

 GASEPF.src .......................................General Aviation Single Engine Propeller Fixed 
pitch aircraft 

 GASEPV.src .....................................General Aviation Single Engine Propeller 
Variable pitch aircraft 

 

 

C . 4  M i s c e l l a n e o u s  S o u r c e s  
 

  

 Omni.src ...........................................Generic omni-directional aircraft, spectra taken 
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APPENDIX D:   
Grid  ( * . t ig )  and Site  ( * . t is )  F i le  Formats  

This appendix is provided for advanced users who want to use multiple computers to run a large 
and complex case.  This information is provided to allow you to concatenate the various output 
files.  First, however, you must understand the format of the files themselves. 

When NMSim generates either the site output (*.tis) or the full grid output (*.tig), it generates a 
file which comes in several parts.  First, there is a header.  The two output files have different 
header information.  The header section of the files is terminated by a line which says ‘---End File 
Header---’.  Following the header information is the actual noise data.  The noise data is the same 
for both site and full grid output files.  It is saved in a series of time histories.  The time histories 
also have short header information before the noise data is recorded.  Each time history ends 
with the line ‘---End of This Data Section---’. 

The following header was taken from a full grid (*.tig) file: 

 
The grid file name. 

These are some of the build files used to generate this time 
history.  These files, in order, are the elevation file, the 
impedance file, the receiver site file, the background layer 
file, and the ambient noise files. 

Left, right, and max number of X grid points. 
Bottom, top, and max number of Y grid points. 

The trajectory file and associated 
source file, repeated for all sources. 
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The following header was taken from a full grid (*.tis) file: 

 

The following is the time history section of a data file:  
 

 

 

 

 

 

 

The final column of values (not shown above) is the D-Prime level for that spectrum, based on 
the ambient value listed in the first row.  D-Prime is a metric that provides an estimate of the 
audibility of a signal.  Levels that are above 5 are considered audible while levels below 5 are 
considered inaudible. 

The default for the date and time of the data is the date on which the data was generated.  A 
different value will be generated if this data was created with the NMSim Scheduler.  Following 
the ‘Echo’ line is a line showing the headings of the following data.  SP# is the number of the data 

- This is the data position name.  If this is part of a full grid analysis, the name uses iiiijjjj for the grid point. 
- Total number of time steps in trajectory and data file. 

- This line and the one above give the position   of 
the data point in Lat/Long, User, and UTM - The data and time for this data. 

- Not used. 

. . 

The grid file name. 

These are some of the build files used to generate this time 
history.  These files, in order, are the elevation file, the 
impedance file, the receiver site file, the background layer 
file, and the ambient noise files. 

The trajectory file and associated 
source file, repeated for all sources. 
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point.  Number 0 gives the ambient levels.  Time is the time that the sound arrived at that data 
point.  ‘F’ is the flat weighted sound level.  ‘A’ is the A-Weighted sound level.  The numbers 
following the A represent the 1/3 octave band number.  The frequency associated with a band 
number can be found by using the formula Error! Objects cannot be created from editing field 
codes..  For example, band 19 represents the 10^1.9 = 79.43 , or the 80 Hz frequency band.  These 
bands go up to the 41st band, or 10^4.1 = 12589, or the 12,500 Hz frequency band. 

The data follows the header with each line representing another point along the flight track.  The 
data is recorded in Centibels.  Therefore, a value of 330 actually means 33.0 dB.  A value of –999 
represents a data point which wasn’t calculated.  This is because either the frequency was out of 
range of the source data, or that this data point is so far from the source that the noise would be 
well below the local ambient and therefore be completely inaudible. 

Concatenation of Grid Output Files 

If you wish to use multiple computers to generate the output to speed up the processing time, it 
will be necessary to add the results from all of the computers into a single file.  While this process 
is useful for speeding up the analysis time, caution should be used when running very large 
cases.  The *.tig files that result from large cases can be large, requiring more than 1 GB of 
memory of disk storage.  Concatenating large files like this may be difficult due to computer 
memory limitations.  That being said, the process of concatenating files is fairly simple.  To 
concatenate the full grid files you must first correct the header of one of the files.  To do this, 
change the II and JJ information to match the actual data you have.  For example, if you have a 
study are with a total of 1000 grid points in both the X and the Y, and you ran this data on 4 
computers, each taking one quarter of the total area.  One of the files may have a header with the 
following lines: 

ii:    1   250  1000 

jj:    1   250  1000 

This represents the lower left corner of the study area.  This must be changed to represent the 
whole are as follows: 

ii:    1  1000  1000 

jj:    1  1000  1000 

The statement must conform to the following FORTRAN format statements: 

'(''ii: '',i4,2x,i4,2x,i4)') iileft,iiright,iimax 

'(''jj: '',i4,2x,i4,2x,i4)') jjbottom,jjtop,jjmax 
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After the header has been changed, each of the other files should be copied (minus the header) 
and pasted to the end of that file.  The order in which they are pasted does not matter. 

When the resulting file is loaded into the NMSim Visualizer, it will display all of the data for the 
entire run. 

It should be noted that grid files (*.tig files) can be so large as to be difficult to open with any 
standard editor.  Given the limits of computer memory, it is possible to create an analysis so 
detailed that the computer just can not handle the manipulation of the data. If the case you are 
producing ends up being so large as to be unworkable then you need to ask whether the 
increased resolution sought with the extremely detailed analysis is actually giving more useful 
practical results than a simpler, smaller grid analysis.  This is a question that must be answered 
on a case-by-case basis and has no easy solution. 
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Appendix E:   
Video Making Software (BitMapsToAvi) 

 

This Appendix is provided for users who want to go back and make changes to a video, provided 
that they have kept the intermediate image capture files. 

BitmapsToAVI is a Microsoft Windows-based command line utility for converting a sequence of 
bitmap images into an AVI movie.  Each bitmap is one frame in the movie. 

BitmapsToAVI reads a series of bitmap images stored in a sequence of files.  All of the bitmap 
files must be located in the same directory, and must have identical file names, with the exception 
of a number at the end of the file name, but before the extension.  For example: 

c:\temp\MyBitmap1.bmp 

c:\temp\MyBitmap2.bmp 

c:\temp\MyBitmap3.bmp 

BitmapsToAVI can read the following types of bitmap image files: 

BMP: 1-, 4-, 8-, 16-, 24-, and 32-bits 

JPEG: 8- and 24-bits 

PNG: 1-, 4-, 8-, 16-, 24-, 32-, and 64-bits 

TIFF: 1-, 8- and 24-bits, uncompressed 

BitmapsToAVI writes movies in AVI format.  This is a widely supported animation format that 
can be played using most third-party multimedia applications (for example, Windows Media 
Player).  Both 24-bit color (true color) and 8-bit color palette AVIs are supported.  8-bit color AVIs 
can be compressed using Run Length Encoding (RLE). 
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BitmapsToAVI is a command line program, meaning that it is run from the windows command 
line (also called the DOS box).  All options are passed to the program as command line options.  
The following options are supported: 

 -AVIFile <avifilename> 
 Purpose: Set the name of the AVI movie file that will be created 
 Example: BitmapsToAVI -AVIFile MyMovie.avi 
 Default Value: The same name as the first bitmap image file, with the trailing number 

removed and the extension changed to ".avi".  For example, if the first bitmap image 
file is named "c:\mydata\movie1.bmp", then by default, the AVI file will be named 
"c:\mydata\movie.avi". 

 If the file name has spaces in it, enclose the entire name with double quotes: for 
example, -AVIFile "c:\my data\my movie.avi". 

 Restrictions: The movie file should have the extension ".avi".  Otherwise, many third-
party multimedia applications will not play it. 

 -Bitmaps <bitmapfilename> 
 Purpose: Set the name of the bitmap images that will be read 
 Example: BitmapsToAVI -Bitmaps c:\mydata\mybitmap1.bmp 
 Default Value: Bitmap1.bmp 
 Description: The -Bitmaps option is used to specify the file name of one of the bitmap 

images that you want BitmapsToAVI to read.  It does not matter which one.  
BitmapsToAVI will locate all files that have the same name, with the exception of a 
different trailing number at the end of the file name.  BitmapsToAVI will then sort the 
files names by the trailing numbers and process the bitmap image files in that order. 

 If the file name has spaces in it, enclose the entire name with double quotes: for 
example, -Bitmaps "c:\my data\my bitmap 1.bmp". 

 -Format <formatname> 
 Purpose: Set the format (color depth and compression) of the AVI movie 
 Example: BitmapsToAVI -Format 24BitColor 
 Default Value: Depends on the color depth of the first bitmap image file.  If it is 8 or 

fewer bits per pixel, then 8BitColorRLE is used.  Otherwise, 24BitColor is used. 
 Restrictions: <formatname> must be one of the following values: 

 24BitColor   : 24-bit color (true color), uncompressed 
 8BitColor    : 8-bit color, optimal palette, uncompressed 
 8BitColorRLE : 8-bit color, optimal palette, compressed with RLE 
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 -Speed <fps> 
 Purpose: Set the movie playing speed in frames per second 
 Example: BitmapsToAVI -Speed 15 
 Default Value: 10 frames per second 
 Restrictions: <fps> must be a number between 0.01 and 100. 

 -Size <width> <height> 
 Purpose: Set movie dimensions in pixels 
 Example: BitmapsToAVI -Size 300 200 
 Default Value: The dimensions of the first bitmap image. 
 Description: Sets the dimensions of the movie, in pixels.  You will rarely set the movie 

dimensions larger than your bitmap images.  However, it can be useful to set the 
movie dimensions smaller than your bitmap images.  For example, if you want your 
movie to be, say, 300x300 pixels, you may generate your bitmap images at 900x900 
pixels, and draw all lines, text,  tc. at three times their normal size.  BitmapsToAVI will 
resample your bitmap images to the smaller size, smoothing jagged diagonal lines.  
Technically, this anti-aliases your movie. 

 Restrictions: Both <width> and <height> must be integers between 2 and 10,000. 

 -KeyFrameInterval <interval> 
 Purpose: Set the number of frames between each key frame 
 Example: BitmapsToAVI -KeyFrameInterval 10 
 Default Value: 25 
 Description: This option is relevant only when creating a compressed AVI movie.  

Most frames of a compressed movie are dependent upon previous frames: only the 
difference between the old and new frame is included in the movie.  This reduces the 
movie's size considerably. 

A key frame is a frame that does not depend on previous frames.  By definition, the 
first frame in a movie must be a key frame.  Technically, no other key frames are 
needed.  However, it is a good idea to periodically include key frames in a movie, so 
that multimedia players can easily skip to any point in the movie without having to 
decode the entire movie up to that point. 

<interval> is the interval between key frames in your movie.  Every <interval>'th 
frame will be a key frame. 
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Increasing the key frame interval reduces the size of the movie, while decreasing the 
key frame interval makes for quicker seeks when playing the movie. 

Typical keyframe intervals range from 10 to 100. 

 Restrictions: <interval> must be an integer >= 1 

 -KeepWindow 
 Purpose: Cause BitmapsToAVI to pause after it has created a movie 
 Example: BitmapsToAVI -KeepWindow 
 Default Value: No pause.  BitmapsToAVI immediately exits. 
 Description: When BitmapsToAVI runs, it writes a summary of its actions to the 

screen.  The window displaying this summary disappears when the movie has been 
created. 

If you are debugging a BitmapsToAVI command line, it can be useful to view this 
summary information in detail.  The -KeepWindow command line option will cause 
BitmapsToAVI to pause after creating the movie.  Using the mouse and the scroll bar, 
you can scroll through the summary information and read it.  Press any key to cause 
BitmapsToAVI to exit. 

 Restrictions: Do not use if the -Hidden command line option is used. 

 -Hidden 
 Purpose: Hides the BitmapsToAVI window 
 Example: BitmapsToAVI -Hidden 
 Default Value: Not hidden.  The window is displayed. 
 Description: When BitmapsToAVI runs, it displays a window that shows a summary 

of BitmapsToAVI's actions.  This summary is updated as each bitmap image is 
processed. 

 If BitmapsToAVI is launched from a script file or a third-party application, it may be 
desirable to hide this window.  If the –Hidden command line option is used, the 
window will not appear. 

 Restrictions: Do not use if the -KeepWindow command line option is used. 

 -HideErrors 
 Purpose: Causes BitmapsToAVI to hide any errors that occur 
 Example: BitmapsToAVI -HideErrors 
 Default Value: Errors are displayed in a pop-up dialog box 
 Description: By default, if BitmapsToAVI detects any errors, it displays them in a pop-

up dialog box.  This is true even if the -Hidden command line option is specified. 
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 If BitmapsToAVI is launched from a script or a third-party application, it may be 
desirable for the script or application to handle error reporting.  The -HideErrors 
command line option will prevent BitmapsToAVI from displaying errors.  
BitmapsToAVI always writes any errors to a file named BitmapsToAVIErrors.txt.  
This file will be located in the same directory as BitmapsToAVI.exe.  Scripts and third-
party applications can check for the existence of this file to determine if an error 
occurred.  If this file exists, the first line of the file will contain a short  description of 
the error, suitable for display as the title of an error dialog box.  Subsequent lines will 
contain a detailed description of the error. 

Note: BitmapsToAVI uses a command line option (-HideErrors) to indicate that errors should be 
hidden.  If there is an error in the command line itself, there is no way to prevent the error from 
being displayed by BitmapsToAVI.  In practice, this tends not to be a problem.  Simply insure 
that the script or third-party application that runs BitmapsToAVI uses a valid command line. 

Note: BitmapsToAVI also creates a log file every time it runs.  This file is named 
BitmapsToAVI.log, and it will be located in the same directory as BitmapsToAVI.exe.  Usually, 
you can ignore this file.  However, if BitmapsToAVI ever crashes, this log file may contain 
valuable debugging information that will help determine the cause of the crash. 

General Notes About Command Line Options 

Command line options are not case-sensitive.  For example, -size, -Size, and -SIZE are all 
equivalent. 

Command line options can be specified in any order. 

All command line options have default values.  None are required. 
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 APPENDIX F: 

NMSim Batch Files 

 
This Appendix is provided for advanced users who will want to create and run their own 
NMSim batch runs, without benefit of the NMSim Scheduler interface. 

To create a NMSim batch file, you need to already have created the necessary NMSim control file 
(see Appendix G).  The following show you how to write the batch file (using the Fortran format 
convention): 

write(*,'(a4)') 'open' .......................................This command tells the program to open the next file listed. 

“nmsim control file”.....................................This is the place to put the control file name with the full path. 

If you want to do a full grid analysis, use the following: 

write(*,'(a4)') ‘grid’ ........................................This is a key word telling the computer to do a grid analysis. 

“timfile” ..........................................................This is the output time file name (without extension) with the 
full path. 

write(*,'(''ii: '',i3)') iimax ...............................The max number of grid points (this will be to final resolution). 

write(*,'(''set:'',2i4)') iileft,iiright.................The left and right grid points of the study area for sub-griding. 

write(*,'(''ii: '',i3)') jjmax ...............................The max number of grid points (this will be to final resolution). 

write(*,'(''set:'',2i4)') jjbottom,jjtop.............The bottom and top grid points of the study area for 
sub-griding. 

If you only want to do the site analysis, you only need to use the key word ‘site’.  After the key 
words use the following: 

write(*,'(‘’dbf: ‘’,a3)')  ‘no’ or ‘yes’ ..............This determines if the results will be written into a DBF file. 

Any additional information can be added to this file for information purposes.  If you want to do 
another calculation within this batch file, start it off with the open command.  To end the session 
you can put either an end or a stop command at the end of your run.  To run the command line, 
go to the directory where NMSim is installed, then from the DOS prompt type ‘nmsimbatch ’ 
followed by the file name of your script file.  It should then generate the output files into the 
selected file name. 
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 APPENDIX G: 

NMSim Control File 

 
This Appendix is provided for advanced users who want to write their own control files without 
using the user interface. 

NMSim uses a control file to store all of the data for a given run.  This control file uses the suffix 
*.nms.  The file lists the input files used to generate the case, plus gives the last set of contour 
intervals used by the user.  The format is as follows: 

Elevation File 

Impedance File 

Receiver Site File 

Trajectory File 

Then, the next two lines just have hyphens in them: 

- 

- 

Source File 

Contour interval (in meters) 

Background Layer File 

Ambient Noise File 

The two lines that only have hyphens in them are there as place holders for features that are not 
ready for general use.  Future versions of NMSim may implement those features. 

It is important to put the full path into these file names, and make sure that this file is saved as a 
plain text ASCII file (with the extension *.nms).  Rich text and advanced word processing 
programs add fromatting data which will not work with NMSim.  If you use Wordpad, make 
sure to save the file as text and not Unicode.  Some Windows editors will insist on naming the file 
with the extension ‘.txt. ‘ Just rename the file afterwards. 

 

 


